Report Studio Developer Training
Part 1

IBM Cognos

September 2011
This training documentation is the sole property of Infolink Consulting. All rights are reserved. No part of this document may be reproduced.

Exception: The University Corporation for Atmospheric Research (UCAR) has the right to reuse these materials internally, including the right to further modify these materials and to train additional users. Any other use of these materials is not authorized.

These materials were customized for UCAR on IBM Cognos 10.
# Table of Contents

Chapter 1 – Getting Started ................................................................. 1  
Introductions ....................................................................................... 1  
General Housekeeping ....................................................................... 1  
Overview of IBM Cognos 10 ................................................................. 2  
What is Framework Manager? .............................................................. 3  
What is IBM Cognos Connection? ......................................................... 4  
Business Insight Advanced or Report Studio? ....................................... 4  
Getting Started ................................................................................... 5  
Understanding IBM Cognos Connection ............................................. 6  
Navigating in IBM Cognos Connection ................................................. 7  
Run a Report ....................................................................................... 9  
Understanding IBM Cognos Viewer ................................................... 13  
View Public Reports .......................................................................... 15  
Schedule Reports ............................................................................... 16  
Personalize the Portal ....................................................................... 16  

Chapter 2 – List Reports ................................................................. 19  
Report Studio Navigation ................................................................... 19  
Create a simple list report with filters ............................................... 23  
Filters .................................................................................................. 25  
Grouping ............................................................................................. 27  
Group Span ......................................................................................... 28  
Sorting ................................................................................................ 30  
Counting ............................................................................................. 31  
Add Report Totals ............................................................................. 34  

Chapter 3 – Aggregations and Calculations ....................................... 37  
Record Counts .................................................................................... 37  
Aggregation and Calculations ............................................................. 42  
Forecasting ......................................................................................... 46  

Chapter 4 – The Query Model .......................................................... 49  
Examine the Query Model ................................................................. 49  
Cut vs. Delete ..................................................................................... 51  
Build and Modify Query Models ....................................................... 52  
Auto Group & Summarize .................................................................. 56  
Generate the SQL ................................................................................ 59  
Add the Query to the Page ................................................................. 60  

Chapter 5 – Conditions and Filters .................................................. 63  
Filter Syntax Guidelines ..................................................................... 63  
Aggregate Filters ............................................................................... 64  
Using a Detail Filter ............................................................................ 65  
Using a Report Row Filter .................................................................. 70  
Using a Summary Filter ..................................................................... 73  
AND / OR Statements ....................................................................... 77  
Prompts .............................................................................................. 84  

Chapter 6 – Report Design ............................................................. 95  
Report Formatting (Aesthetics) ........................................................... 95  
Using Tables to Organize Page Objects ............................................ 100
Layout Calculations .............................................................................................. 102
Headers and Footers ........................................................................................... 104
Adding Header Pages .......................................................................................... 111
Using Create Sections for Grouping .................................................................. 113
Chapter 7 – Presenting Data Graphically .......................................................... 117
  Creating Various Chart Layouts ....................................................................... 117
  Creating Custom Chart Palettes ....................................................................... 126
Chapter 8 – Additional Report Options ............................................................. 131
  Creating a Simple Crosstab Report .................................................................. 131
  Customizing Reports with Conditional Formatting ........................................... 134
  Creating Repeaters ......................................................................................... 137
  Creating a Template ......................................................................................... 141

***Notes pages are in the back of this binder for your use.***
Chapter 1 – Getting Started

Introductions

Please share the following information with your classmates so that we can get to know each other better:

- Name
- Title and Time in Your Current Position

General Housekeeping

- Please put your cell phones on vibrate to minimize classroom distractions.
- You are encouraged to write down and submit questions that the instructor cannot answer. Your instructor will research your questions so that they can be addressed at a later time.
- Your instructor will set break times throughout this course, and the class will begin promptly at the agreed upon start time.
Chapter 1 – Getting Started

Overview of IBM Cognos 10

Components and license roles in IBM Cognos 10 Business Intelligence (BI) tool suite:

<table>
<thead>
<tr>
<th>IBM Cognos Component</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metric Studio</td>
<td>Monitor performance against benchmarks and priorities</td>
</tr>
<tr>
<td>Event Studio</td>
<td>Invoke tasks, and track events and processes</td>
</tr>
<tr>
<td>Report Studio</td>
<td>Create managed reports – most advanced studio</td>
</tr>
<tr>
<td>Query Studio</td>
<td>Create ad hoc reports</td>
</tr>
<tr>
<td>Analysis Studio</td>
<td>Explore and analyze data</td>
</tr>
<tr>
<td>Business Insight Advanced</td>
<td>Author reports with relational or dimensional data and analyze data in lists, crosstabs, and charts.</td>
</tr>
<tr>
<td>Business Insight</td>
<td>Build and use sophisticated, interactive dashboards using IBM Cognos content as well as external data sources.</td>
</tr>
<tr>
<td>IBM Cognos Viewer</td>
<td>View results of all reports, queries, and analyses. IBM Cognos Viewer shows report output after a user has interacted with any prompts.</td>
</tr>
<tr>
<td>IBM Cognos Connection</td>
<td>Access all data available through IBM Cognos</td>
</tr>
<tr>
<td>Framework Manager</td>
<td>Create and publish metadata models on which reports are based. Business Insight Advanced, Query Studio, and Report Studio can report from all models. All studios can report from dimensionally modeled relational data (which can be created in Framework Manager)</td>
</tr>
<tr>
<td>Transformer</td>
<td>Create and publish cubes on which reports are based. Business Insight Advanced, Query Studio, Analysis Studio, and Report Studio all can report from cubes</td>
</tr>
<tr>
<td>Metric Designer</td>
<td>Create scorecards and metrics</td>
</tr>
</tbody>
</table>
Chapter 1 – Getting Started

Let’s take a closer look at three of the key components you use to model, access, and analyze your data.

What is Framework Manager?

Framework Manager is the metadata modeling tool that allows you to model relational data. Framework Manager and Transformer are client applications (not web-based), but all other components listed previously are web-based.

The result of a Framework Manager model is a package(s). When packages are published, this is the first time a report developer can create a report against that data using either Business Insight Advanced or Report Studio.
Chapter 1 – Getting Started

What is IBM Cognos Connection?

IBM Cognos Connection is the portal interface to all of the functionality available in IBM Cognos 10. It is a web application for viewing, creating, and managing queries and reports. In the portal, you can:

- View public reports.
- Create and run reports.
- Perform administrative tasks, such as scheduling and distributing reports.
- Organize data by creating entries and storing the entries in folders.
- Personalize the portal to meet your needs.

Business Insight Advanced or Report Studio?

Determining whether to use Business Insight Advanced or Report Studio to analyze your data and develop reports depends on a number of factors, in addition to your IBM Cognos licensing.

<table>
<thead>
<tr>
<th>Business Insight Advanced</th>
<th>Report Studio</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Insight Advanced is an easy-to-use authoring tool with which you can quickly create queries from the data stored in your database or from external data without having the skills of a professional report writer. Business Insight Advanced can also be used for exploring information in multiple dimensions and for deep comparative analysis, enabling business users to get fast answers to business questions by trending or analyzing your organization’s information assets.</td>
<td>With Report Studio, you can create advanced reports with more flexibility than any other studio available in Cognos. Report Studio reports can contain charts, maps, lists, repeaters, or any other available report types using static data from relational or multi-dimensional data sources.</td>
</tr>
<tr>
<td>- Limited prompting is available for report design.</td>
<td>- Use for a more official, published report versus a query or analysis for internal use.</td>
</tr>
<tr>
<td>- Send reports to a professional user for further development in Report Studio</td>
<td>- Knowledge of SQL fundamentals is helpful.</td>
</tr>
</tbody>
</table>
Chapter 1 – Getting Started

Step-By-Step

Getting Started

1. From a web browser, type the following URL:
   https://fagrand.fanda.ucar.edu/ibmcognos.

With single source authentication for your environment, the system should recognize your CIT account and grant you access to IBM Cognos.

The Welcome Page may appear, with links to IBM Cognos Connection (IBM Cognos content) and the IBM Cognos modules available to you. Note that you have the option to uncheck the Show this page in the future box in order to bypass this page.
Understanding IBM Cognos Connection

Once you have successfully logged into IBM Cognos, or selected IBM Cognos content from the Welcome Page, the portal appears. This is the primary way to access Report Studio and the associated reports and reporting tools. The web interface means that nothing needs to be maintained on the user’s desktop.

**NOTE**

The reason the portal is the primary way to access IBM Cognos Report Studio is that developers can create hyperlinks to reports directly from another application or web page. This bypasses IBM Cognos Connection after authenticating the user.
Step-By-Step

Navigating in IBM Cognos Connection


2. Click on the IBM Cognos Training folder link to navigate back up.

3. Click on the My Folders tab to navigate to your personal work space.
Chapter 1 – Getting Started

4. Create a personal folder in the My Folders tab.
   a. Click on the New Folder icon.
   b. Type “Report Studio Part 1 Training” in the Name box.
   c. Click Finish.

Folder Tools

As you navigate through the Public Folders and My Folders tabs, a Toolbar of available options displays. The Toolbar shows the actions that can be performed in the portal. They are described below.

- Refresh the portal
- Show entries in a list
- Show detail information for each entry
- Create a folder
- Create a new package
- Create a new dashboard
- Run multiple reports
- Create a URL to an external file or web site

Create a page
Cut the selected entries
Copy the selected entries
Paste clipboard contents to the current location
Delete the selected entries
Set the properties for the current folder or package
Set the order for folders or entries

NOTE
These icons vary based on licensing permissions and only appear where they are relevant. On some pages they are not displayed.
Chapter 1 – Getting Started

Step-By-Step

Run a Report

1. Navigate to Public Folders > IBM Cognos Training > Report Studio Part 1 Training > Chapter 1 > Travel Costs.
2. Review the report options available in the Actions menu.

- Set/modify properties
- Create a report view (shortcut)
- View the output versions
- Schedule recurring jobs
- Run with options
- All available report options
- Open the report in Report Studio

3. Click on the Run with options icon under Actions.
Chapter 1 – Getting Started

4. Select any options needed for this report execution. For now, select HTML and click Run.

Select how you want to run and receive your report.

**Format:**
- HTML
- PDF
- EXCEL 2007
- EXCEL 2002
- Delimited text (CSV)
- XML

**Accessibility:**
- Enable accessibility support

**Language:**
- English (United States)

**Delivery:**
- **View the report now**
- **Save the report**
- **Print the report**
  - **Printer location:**

**Prompt values:**
- No values saved
- Prompt for values

[Run] [Cancel]
Developers can specify a default format in the properties of any report. Selecting the PDF option (as the default or at runtime) requires Adobe Reader on the user’s desktop.

If the report has a prompt page, you see it in HTML as shown below, regardless of the report output format you select (prompting is discussed in more detail later).

Your report executes and displays the results in IBM Cognos Viewer. This is the interface used to display reports regardless of the interface used to develop the report (Business Insight Advanced or Report Studio, for example).

### Travel Costs for PEID

#### By Fiscal Year

<table>
<thead>
<tr>
<th>Person Entity Identifier - PEID</th>
<th>Last Name</th>
<th>First Name</th>
<th>Fiscal Year</th>
<th>Account Number</th>
<th>Travel Expense Record Count</th>
<th>Net Amount</th>
<th>Average TE</th>
</tr>
</thead>
<tbody>
<tr>
<td>011337</td>
<td>OGR</td>
<td>EDDIE</td>
<td>2008</td>
<td>150008</td>
<td>3</td>
<td>$3,190.13</td>
<td>$1,063.38</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2008</td>
<td>160011</td>
<td>4</td>
<td>$5,317.64</td>
<td>$1,320.38</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2008</td>
<td>150022</td>
<td>3</td>
<td>$2,993.09</td>
<td>$694.53</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2008</td>
<td>150952</td>
<td>1</td>
<td>$602.69</td>
<td>$602.69</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2008</td>
<td>150954</td>
<td>4</td>
<td>$3,954.20</td>
<td>$999.05</td>
</tr>
<tr>
<td>2008 - Total</td>
<td></td>
<td></td>
<td>15</td>
<td></td>
<td></td>
<td>$15,460.61</td>
<td>$1,044.33</td>
</tr>
<tr>
<td>2009</td>
<td>150008</td>
<td>3</td>
<td>3</td>
<td></td>
<td></td>
<td>$3,170.84</td>
<td>$1,056.95</td>
</tr>
<tr>
<td></td>
<td>160011</td>
<td>6</td>
<td>6</td>
<td></td>
<td></td>
<td>$3,975.00</td>
<td>$1,324.50</td>
</tr>
<tr>
<td></td>
<td>150022</td>
<td>2</td>
<td>2</td>
<td></td>
<td></td>
<td>$2,774.26</td>
<td>$1,387.13</td>
</tr>
<tr>
<td></td>
<td>150952</td>
<td>1</td>
<td>1</td>
<td></td>
<td></td>
<td>$602.69</td>
<td>$602.69</td>
</tr>
<tr>
<td></td>
<td>150954</td>
<td>2</td>
<td>2</td>
<td></td>
<td></td>
<td>$784.71</td>
<td>($347.36)</td>
</tr>
<tr>
<td>2009 - Total</td>
<td></td>
<td></td>
<td>19</td>
<td></td>
<td></td>
<td>$14,851.36</td>
<td>$764.00</td>
</tr>
<tr>
<td>2010</td>
<td>150011</td>
<td>2</td>
<td>2</td>
<td></td>
<td></td>
<td>$1,952.63</td>
<td>$976.32</td>
</tr>
<tr>
<td></td>
<td>150022</td>
<td>0</td>
<td>0</td>
<td></td>
<td></td>
<td>$624.75</td>
<td>$624.75</td>
</tr>
<tr>
<td></td>
<td>290001</td>
<td>5</td>
<td>5</td>
<td></td>
<td></td>
<td>$4,439.61</td>
<td>$887.92</td>
</tr>
<tr>
<td>2010 - Total</td>
<td></td>
<td></td>
<td>15</td>
<td></td>
<td></td>
<td>$14,928.08</td>
<td>$995.20</td>
</tr>
<tr>
<td>011337 - Total</td>
<td></td>
<td></td>
<td>49</td>
<td></td>
<td></td>
<td>$42,100.88</td>
<td>$862.40</td>
</tr>
</tbody>
</table>
Clicking on the report name itself to view a report may or may not display the most current data. It is more consistent to always Run with options. Clicking on the Report View link to a report allows you to view a report without having to re-input prompt parameters, but again, the data may not be the most current.

**Understanding IBM Cognos Viewer**

While viewing a report in IBM Cognos Viewer, you can perform many actions that are available from the Run with options and the Run with advanced options pages.

The Keep this version drop-down box provides options to email or save the report. Saving the report as a Report View is like creating a “shortcut”.

Run the report again with the blue arrow:

Drill down and Drill up allow users to navigate through dimensionally modeled data (Note: This report is not using dimensionally modeled data- thus the buttons are inactive).

Drill-thru takes users to a related report.
Chapter 1 – Getting Started

The View options are available in another drop-down box: 

The Add this report drop-down box allows users to quickly add the report to My Folders or My Bookmarks

You can open the report in Report Studio by clicking on the triangle . Clicking on the arrow returns you to the same folder. Clicking on Home returns you to IBM Cognos Connection home.

Clicking on the Browser’s X button closes IBM Cognos Viewer and IBM Cognos Connection!

NOTE

When using IBM Cognos Viewer in HTML output, always check to see if there is a Page Down option in the bottom left of the report. There may be more data that isn’t displayed on the initial page.

Aug 10, 2011

Page down Bottom
1. Click on the Home icon to return to IBM Cognos Connection.
2. In Public Folders, click on the down arrow beside the Search box and select Name field.
3. Type "Training" in the Search box and press Enter or click .
4. From the search results, navigate to IBM Cognos Training > Report Studio Part 1 Training > Chapter 1. There is a sample report called Report View of Travel Costs. Click on the output versions as shown below.

   ![Output Formats](image)

   Note there are three output formats, all with the same data. This is an option chosen by the creator of the report view.

5. Click the Close button.
The instructor will now demonstrate how to click the Run with options button on that same report to schedule it to run.

Users can schedule their reports to run in the background now or at some date / time in the future on any report. This is useful for longer running reports.

1. Click on the My Area Options drop-down arrow in the upper right section of the portal:
2. In **My Preferences**, you can personalize your portal view with the following options. Please set the **Number of entries in list view** property to **25**, and the **Separators in list view** drop-down to **Alternating backgrounds** and click OK.

![Preferences settings](image)

Note the alternating backgrounds now in this short list of reports.

<table>
<thead>
<tr>
<th></th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Report View of Travel Costs</td>
</tr>
<tr>
<td></td>
<td>Travel Costs</td>
</tr>
</tbody>
</table>
Chapter 2 – List Reports

A list report shows data row by row, or record by record. Many users think of this as “detailed data” or “transaction level data”, which is not always the case, depending on the data source and the query populating the list report.

Report Studio List Report

Now that we’ve seen what a list report looks like, let’s see how it was developed in Report Studio. It could also have been developed in Business Insight Advanced. For the purposes of this class, we’ll review the development in Report Studio.

Step-By-Step

Report Studio Navigation

1. We’ll first review navigation in Report Studio: From Public Folders > IBM Cognos Training > Report Studio Part 1 Training > Chapter 2 > Travel Costs, click on the Open with Report Studio icon.

<table>
<thead>
<tr>
<th>Name</th>
<th>Modified</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Travel Costs</td>
<td>August 17, 2011</td>
<td></td>
</tr>
</tbody>
</table>

2. If a prompt page appears, click Cancel.
The user interface is displayed as follows:

- **Page Header/Footer** – above and below the red line
- **Insertable Objects**
- **Work Area** – where the report is built
- **Explorer Bar** – contains the Page, Query, and Condition Explorers
- **Properties Pane** – shows attributes associated with report objects

**NOTE**

The Page layers and Context filters windows at the top of the report page are only used for dimensional data. To remove them from the view, click on the blue arrow.
Chapter 2 – List Reports

Note that the Insertable Objects pane has 3 tabs:

The Source tab allows the developer to insert items directly from the Framework Manager package that was selected.

3. Click on the Data Items tab to see that once you have inserted items from the package into a report page or query, they are displayed here.
4. Click on the Toolbox to display all of the special features and formatting options that IBM Cognos provides to add functionality and flexibility to your reports.
5. Highlight different items in the report to see the properties for that item displayed in the Properties pane.
Inserting objects into your report

Drag - When dragging into a list make sure that you see a triple vertical bar at your insertion point. Ctrl-click to select and insert multiple items at a time. When dragging near another object, a dark single bar on the left indicates that the object is placed above the existing object. A bar on the right indicates placement below the existing object.

Double-click – this inserts the object at the end of the list, or at the current cursor placement.

Right-click – first select the item, right-click and select Insert. Objects are inserted at the end of the list, or at the current cursor placement.

6. From the File menu, select **Save As**.
Chapter 2 – List Reports

7. In the Save As window, click on My Folders to navigate to your new folder, double-click on the folder, change the name of the report if you wish, and click Save.

Step-By-Step

Create a simple list report with filters

1. Click on the New icon in the Toolbar to launch a new report using the UCAR Training package.
2. Choose List and click OK.

3. In the Insertable Objects pane, in the Source tab, navigate to the CPM Training Data namespace, General Ledger namespace, Account query subject, and then expand it.

4. Insert the following query items:
   - Account Number
   - Medium Title

5. Now open the General Ledger Details query subject, and insert the following items (drag) into your report:
   - Object Code
   - Post Date
   - Net Amount

**NOTE**

The ordering of query subjects and query items in the Insertable Objects is controllable in Framework Manager. Navigation in the package can also be easier when noting the various icons that reflect the data type of query items, i.e., character, measure, and date.

6. Open the Object Code query subject and insert Medium Description after the Object Code. (Wait for the flashing triple bar!)

7. Open the Date query subject and add Fiscal Year to the end of your report.
Your report specification should look like this:

<table>
<thead>
<tr>
<th>Account Number</th>
<th>Medium Title</th>
<th>Object Code</th>
<th>Medium Description</th>
<th>Post Date</th>
<th>Net Amount</th>
<th>Fiscal Year</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Account Number&gt;</td>
<td>&lt;Medium Title&gt;</td>
<td>&lt;Object Code&gt;</td>
<td>&lt;Medium Description&gt;</td>
<td>&lt;Post Date&gt;</td>
<td>&lt;Net Amount&gt;</td>
<td>&lt;Fiscal Year&gt;</td>
</tr>
<tr>
<td>&lt;Account Number&gt;</td>
<td>&lt;Medium Title&gt;</td>
<td>&lt;Object Code&gt;</td>
<td>&lt;Medium Description&gt;</td>
<td>&lt;Post Date&gt;</td>
<td>&lt;Net Amount&gt;</td>
<td>&lt;Fiscal Year&gt;</td>
</tr>
<tr>
<td>&lt;Account Number&gt;</td>
<td>&lt;Medium Title&gt;</td>
<td>&lt;Object Code&gt;</td>
<td>&lt;Medium Description&gt;</td>
<td>&lt;Post Date&gt;</td>
<td>&lt;Net Amount&gt;</td>
<td>&lt;Fiscal Year&gt;</td>
</tr>
</tbody>
</table>

**Filters**

When viewing a report, users seldom want to see all of the data in the database. They want to limit the amount of data returned by defining specific criteria such as a date range, a particular group of people, a geographic area, or a combination of several conditions. Report Studio filters allow the developer to focus the report on the user’s area of interest.

8. Click the arrow next to the Filters icon and select Edit Filters.

Note that there are two tabs, one for Detail Filters, and one for Summary Filters. We’ll get to the Summary Filters tab later. For now, we want to remain on the Detail Filters tab.

9. Click the Add button.
10. In the Create Filter window, select Advanced, and click OK.
11. Select the Data Items tab, and double-click Fiscal Year. We keep our dataset more manageable by limiting our report to a specific year.
12. Complete the expression as shown:

   ```
   [Fiscal Year] = 2010
   ```

13. Click the Validate button to ensure there are No errors. Sometimes there are errors in other parts of the report. This can also mean that there is an error in your expression. To be sure, use the Validate Report button on the Toolbar to see what the exact error is.
14. Click OK once.
15. Add a second Advanced Detail Filter as shown:

   ```
   [Account Number] starts with '16000'
   ```
16. Add a third Advanced Detail Filter as shown:

   `[Net Amount] > 2000`

17. Save the report specification in **My Folders > Report Studio Part 1 Training as List Exercise**.
18. Click Run Report from the Toolbar (Note that your results may be in a different order because we have no sorting on our data items).

   ![Image of a table showing account numbers, medium titles, object codes, medium descriptions, post dates, net amounts, and fiscal years.]

   Note that this information is useful but the data is currently in a long repetitive list. Let’s improve the readability.

19. Return to Report Studio by either closing or minimizing IBM Cognos Viewer.

   **NOTE**

   If you make any mistakes, either before or after saving (as long as you haven’t already closed the report specification), the Undo feature works extremely well and saves the last 10 actions.

   **NOTE**

   When you run a report from the Report Studio interface, it launches a separate browser for IBM Cognos Viewer. You may choose to leave the report output up and toggle back to Report Studio. Next time you click run, by default the previous Report Viewer browser is closed and a new browser is launched for the new report execution.
NOTE
When you resize your IBM Cognos Viewer screen, note by default the data wraps so that it fits within the window.

Step-By-Step

What is a grouped list report? It shows data row by row, but suppresses duplicate values from each grouped data item. Nothing else changes – the number of rows returned is identical to the same “ungrouped” list, but the appearance and readability of the report is improved.

1. Start with your List Exercise.
2. Delete the Fiscal Year column.
3. Single click to highlight Account Number, and then click the Group icon.
4. Highlight the Object Code column, and click the Group icon.
5. Click Run Report from the Toolbar:

Account Number is now listed only once per change in account. Object Code is only listed once for each Object Code within an Account Number.

Next we'll look at a way to remove the repeated results in Medium Title and Medium Description without grouping.

**Step-By-Step**

1. Single click to highlight Medium Title. Look for **List Column Body** next to the Select Ancestor arrow in the Properties pane to be sure you have selected the correct object:

2. Click the Group Span property.
3. Select **Account Number** from the drop-down box.

4. Highlight the **Medium Description** column, and **Group Span based on Object Code**.

5. Click **Run Report** from the Toolbar.

Your report should look like this now (your results may be in a different order because we have no sort on the data). Note that **Medium Title** is now listed just once per occurrence of **Account Number** and **Medium Description** is listed once per occurrence of **Object Code**.
6. Save the report specification as **Group and Span**.

**Step-By-Step**

**Sorting**

Change the sort order of Object Code

1. Continue with the **Group and Span** report.
2. Single click to highlight Object Code, and then click the Sort drop-down to select **Descending**.
3. Save the report as **Sort Desc**.
4. Click Run Report from the Toolbar. Note that the records are now sorted descending based on Object Code.

<table>
<thead>
<tr>
<th>Account Number</th>
<th>Medium Title</th>
<th>Object Code</th>
<th>Medium Description</th>
<th>Post Date</th>
<th>Net Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>160001</td>
<td>MMM Science</td>
<td>5712</td>
<td>Overhead</td>
<td>Feb 12, 2010 12:00:00 AM</td>
<td>2,198.97</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5101</td>
<td>Full Benefits</td>
<td>Feb 26, 2010 12:00:00 AM</td>
<td>2,092.74</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5075</td>
<td>Salaries Casual</td>
<td>Sep 24, 2010 12:00:00 AM</td>
<td>2,722.8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5044</td>
<td>Awards - Prof Spt</td>
<td>Feb 12, 2010 12:00:00 AM</td>
<td>4,032.26</td>
</tr>
<tr>
<td>160002</td>
<td>Journal Page Chr</td>
<td>5711</td>
<td>Overhead</td>
<td>Jan 15, 2010 12:00:00 AM</td>
<td>2,322.43</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Mar 26, 2010 12:00:00 AM</td>
<td>2,678.41</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Jul 30, 2010 12:00:00 AM</td>
<td>2,396.08</td>
</tr>
</tbody>
</table>

**NOTE**

Note that Sorting happens within the lowest grouping level.
Chapter 2 – List Reports

Counting

Now assume that we want to see a count of Document Ids associated with travel per Person Entity Identifier – PEIDs.

1. Create a new List report using the UCAR Training package.
2. From the CPM Training Data namespace, General Ledger namespace, Person query subject, add the following data items:
   - Person Entity Identifier – PEID
   - Name
3. From the Object Code query subject, add:
   - Medium Description
4. From the General Ledger Details query subject, add the Document Id query item to the end of the report.
5. Group on Person Entity Identifier – PEID.
6. Group Span on Name.
7. Sort Ascending on Medium Description.
   Click on the Filters icon, Edit Filters, and add two Advanced Detail Filters as shown:

   ![Expression Definition:](Expression Definition)
   
   ![Expression Definition:](Expression Definition)

   **NOTE**

   Notice that we cannot choose the Custom based on data item option in the Create Filter dialog box since we are creating filters based on query items that are not in our report. The Advanced filter option allows us to add a filter to the report without adding that item to our report page. This option is not available in Business Insight Advanced.
8. Run the report.

Let’s remove the transaction detail and count the number of documents instead.

9. Highlight the Medium Description column to Delete it from your report.
10. Highlight the Document Id column.
11. Next click on the slider bar in the Properties window and slide the bar to the bottom where the Data Item properties are listed.
12. Click on the Aggregate Function property and clicking the down-arrow in the box, select Count Distinct.

13. Click the Validate Report button on the Toolbar to ensure there are no errors.
14. Save the report as Count Exercise.
15. Run the report.
Step-By-Step

Add Report Totals

1. Start with your Sort Desc report specification from earlier in this chapter.
2. Sort the Account Number column Descending.
3. Single-click to highlight Net Amount, click the Summarize icon dropdown and select Total.
4. Save the report specification as Totals.
5. Click Run Report from the Toolbar: Note that Report Studio created a subtotal line for Account Number and Object Code, but not Medium Description and Medium Title.

<table>
<thead>
<tr>
<th>Account Number</th>
<th>Medium Title</th>
<th>Object Code</th>
<th>Medium Description</th>
<th>Post Date</th>
<th>Net Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>160004</td>
<td>MMM Fld. Pro. Su</td>
<td>5711</td>
<td>Overhead</td>
<td>Aug 13, 2010 12:00:00 AM</td>
<td>2,681.4</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Sep 30, 2010 12:00:00 AM</td>
<td>2,374.23</td>
</tr>
<tr>
<td></td>
<td><strong>5711 - Total</strong></td>
<td></td>
<td></td>
<td></td>
<td><strong>5,055.63</strong></td>
</tr>
<tr>
<td>5584</td>
<td>Tech/Sci. equip.</td>
<td>5584</td>
<td></td>
<td>Apr 15, 2010 12:00:00 AM</td>
<td>50,000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Jul 13, 2010 12:00:00 AM</td>
<td>9,875</td>
</tr>
<tr>
<td></td>
<td><strong>5584 - Total</strong></td>
<td></td>
<td></td>
<td></td>
<td><strong>50,875</strong></td>
</tr>
<tr>
<td>5430</td>
<td>Lodging Domestic</td>
<td>5430</td>
<td></td>
<td>Aug 4, 2010 12:00:00 AM</td>
<td>3,257.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Sep 27, 2010 12:00:00 AM</td>
<td>2,554.4</td>
</tr>
<tr>
<td></td>
<td><strong>5430 - Total</strong></td>
<td></td>
<td></td>
<td></td>
<td><strong>5,811.6</strong></td>
</tr>
<tr>
<td>5375</td>
<td>WO Non-Cap Chgbk</td>
<td>5375</td>
<td></td>
<td>Nov 4, 2009 12:00:00 AM</td>
<td>5,183</td>
</tr>
<tr>
<td></td>
<td><strong>5375 - Total</strong></td>
<td></td>
<td></td>
<td></td>
<td><strong>5,183</strong></td>
</tr>
<tr>
<td>5260</td>
<td>Mat-General</td>
<td>5260</td>
<td></td>
<td>Oct 15, 2009 12:00:00 AM</td>
<td>2,134.96</td>
</tr>
<tr>
<td></td>
<td><strong>5260 - Total</strong></td>
<td></td>
<td></td>
<td></td>
<td><strong>2,134.96</strong></td>
</tr>
<tr>
<td>1225</td>
<td>Reimb Trvl Rec</td>
<td>1225</td>
<td></td>
<td>Jul 15, 2010 12:00:00 AM</td>
<td>4,092.21</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Aug 23, 2010 12:00:00 AM</td>
<td>8,501.11</td>
</tr>
<tr>
<td></td>
<td><strong>1225 - Total</strong></td>
<td></td>
<td></td>
<td></td>
<td><strong>23,177.74</strong></td>
</tr>
<tr>
<td><strong>160004 - Total</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>101,237.93</strong></td>
</tr>
</tbody>
</table>
NOTE

This demonstrates the primary difference between using group and group span. When performing aggregations, Report Studio automatically creates subtotals at each grouped field, but not at each group spanned field.

Had you “grouped” on Member Title and Member Description instead of using Group Span, your report would include a redundant subtotal as shown:

<table>
<thead>
<tr>
<th>Account Number</th>
<th>Medium Title</th>
<th>Object Code</th>
<th>Medium Description</th>
<th>Post Date</th>
<th>Net Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>160004</td>
<td>MMM Fld. Pro. Su</td>
<td>1225</td>
<td>Reimb Trvl Rec</td>
<td>Jul 15, 2010</td>
<td>4,892.21</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Aug 23, 2010</td>
<td>6,561.11</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Sep 1, 2010</td>
<td>9,784.42</td>
</tr>
<tr>
<td>1225 - Total</td>
<td></td>
<td></td>
<td>Reimb Trvl Rec - Total</td>
<td></td>
<td>23,147.74</td>
</tr>
<tr>
<td>5260</td>
<td>Mat-General</td>
<td></td>
<td></td>
<td>Oct 15, 2009</td>
<td>2,134.06</td>
</tr>
<tr>
<td>5260 - Total</td>
<td></td>
<td></td>
<td>Mat-General - Total</td>
<td></td>
<td>2,134.06</td>
</tr>
<tr>
<td>5375</td>
<td>WO Non-Cap Chgbk</td>
<td></td>
<td></td>
<td>Nov 4, 2009</td>
<td>5,183</td>
</tr>
<tr>
<td>5375 - Total</td>
<td></td>
<td></td>
<td>WO Non-Cap Chgbk - Total</td>
<td></td>
<td>5,183</td>
</tr>
<tr>
<td>5430</td>
<td>Lodging Domestic</td>
<td></td>
<td></td>
<td>Aug 4, 2010</td>
<td>3,257.2</td>
</tr>
<tr>
<td>5430 - Total</td>
<td></td>
<td></td>
<td>Lodging Domestic - Total</td>
<td></td>
<td>5,811.6</td>
</tr>
<tr>
<td>5584</td>
<td>Tech/Sci. equip.</td>
<td></td>
<td></td>
<td>Apr 15, 2010</td>
<td>50,000</td>
</tr>
<tr>
<td>5584 - Total</td>
<td></td>
<td></td>
<td>Tech/Sci. equip. - Total</td>
<td></td>
<td>59,875</td>
</tr>
<tr>
<td>5711</td>
<td>Overhead</td>
<td></td>
<td></td>
<td>Aug 13, 2010</td>
<td>2,681.4</td>
</tr>
<tr>
<td>5711 - Total</td>
<td></td>
<td></td>
<td>Overhead - Total</td>
<td></td>
<td>5,055.63</td>
</tr>
<tr>
<td>5/11 - Total</td>
<td></td>
<td></td>
<td>MMM Fld. Pro. Su - Total</td>
<td></td>
<td>101,237.93</td>
</tr>
<tr>
<td>160004 - Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>101,237.93</td>
</tr>
</tbody>
</table>
Chapter 3 – Aggregations and Calculations

Aggregate is a term used in many places in Report Studio. There are various levels of “aggregate functions” and aggregation types that can be used in a report. Aggregate does not only mean Total, Average, or Count, as we see throughout the course.

Step-By-Step

1. Create a new List report using the UCAR Training package.
2. From the CPM Training Data namespace, General Ledger namespace, Account query subject, add the following data items:
   - Entity Code
   - Entity Medium Description
   - Division_Program Code
   - Division_Program Medium Description
3. From the General Ledger Details query subject, add Document Id to the end of your report.
5. Group on Entity Code.
6. Set the Entity Medium Description column to Group Span on Entity Code.
7. Sort Ascending on Division_Program Code.
8. Create an Advanced Detail Filter to look at data from 2010 using Fiscal Year from the Source tab as shown:

   Expression: 
   
   ![Expression]

9. Click OK twice to return to the report page.
10. Run your report:

11. Create a calculation by dragging a Query Calculation from the Toolbox to the end of the list report.

12. Type “Travel” in the Create Calculation window, select Other expression, and click OK. (All other choices are for dimensional data.)
As we saw when adding a filter, creating a calculation brings up the Expression Definition window. “Expressions” are used extensively in Report Studio, and are key to building effective reports.

When defining expressions, ALWAYS drag query items from the Insertable Objects pane (either from the Source or the Data Items tab) into the window to avoid typing (user) errors!

13. Click on the Functions tab to find a comprehensive list of the expression-building tools that are available to report authors:
14. Highlight the component as shown below to display the proper syntax in the Tips tab of the Information window.
15. Using an if then else statement from the Constructs folder, complete the expression as shown (notice we are pulling Status from the Source tab):

Expression Definition:
if ([General Ledger].[Object Code].[Object Code] starts with '54')
    then (1)
else (0)

16. Validate ✓ and click OK.
17. Set the Aggregate Function property on your new Travel query item to Total.

<table>
<thead>
<tr>
<th>Data Item</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Data Item</td>
</tr>
<tr>
<td>Name</td>
<td>Travel</td>
</tr>
<tr>
<td>Label</td>
<td></td>
</tr>
<tr>
<td>Expression</td>
<td>if ([General Ledger].[Object Code].[Object Code] st...</td>
</tr>
<tr>
<td>Aggregate Function</td>
<td>Total</td>
</tr>
<tr>
<td>Rollup Aggregate Function</td>
<td>Automatic</td>
</tr>
</tbody>
</table>

18. Control-click to highlight both the Document Id column and the Travel column, click the Aggregate icon and select **Automatic Summary**.
19. Save your report specification as **Count**.

20. Click Run Report from the Toolbar to see the results – a count of the number of documents that reflected the Travel object code for Division_Program Code within each Entity.

<table>
<thead>
<tr>
<th>Entity Code</th>
<th>Entity Medium Description</th>
<th>Division_Program Code</th>
<th>Division_Program Medium Description</th>
<th>Document Id</th>
<th>Travel</th>
</tr>
</thead>
<tbody>
<tr>
<td>CASH</td>
<td>Cash Fund</td>
<td>00</td>
<td>CASH</td>
<td>96</td>
<td>9</td>
</tr>
<tr>
<td>LLC</td>
<td>LLC</td>
<td>81</td>
<td>UCAR Child Care</td>
<td>7</td>
<td>0</td>
</tr>
</tbody>
</table>

**NOTE**

It is extremely important to correctly identify the key field(s) to your query to ensure you get the proper count. You need to select the field(s) that are unique keys and therefore count each detail record. If you select non-key field(s), it might still work but have a different meaning.
Using the **Count Exercise** report from the Chapter 2, let’s determine the average amount of travel expenses per record.

Your report specification should now look like this:

1. Cut Document Id from the report.
2. From the Date query subject, add the Fiscal Year query item to your report specification.
3. From the Account query subject, add the Account Number query item to your report.
4. From the Toolbox tab in Insertable Objects, drag a Query Calculation to the end of your report.
5. Name the Calculation “Travel Expense Record Count”, select Other Expression, and click OK.
Chapter 3 – Aggregations and Calculations

6. Complete the expression as shown. Notice we are pulling Document Id from the Data Items tab.

```plaintext
Expression Definition:
count ([Document Id])
```

7. From the General Ledger Details query subject, add Net Amount to the report.

8. Now let’s add another calculation (drag a Query Calculation into your report from the Toolbox) after Net Amount, name it “Average Amount per Travel Expense Record”, select Other Expression, and click OK.

9. Complete the expression as shown:

```plaintext
Expression Definition:
[Net Amount] / [Travel Expense Record Count]
```

10. Validate ✔️ and click OK.

11. Group the Fiscal Year column.

12. Ctrl-click to highlight the Travel Expense Record Count, Net Amount, and Average Amount per Travel Expense Record columns, and click on the Summarize icon in the Toolbar to set the Aggregate function to Automatic Summary.

13. Edit the Filter on Fiscal Year as shown:

```plaintext
Expression Definition:
```

14. Add an Advanced Detail Filter on the Person Entity Identifier – PEID as shown. (You could also choose to create a custom filter on this data item, since it is in our report.)

```plaintext
Expression Definition:
[Person Entity Identifier - PEID] in ('011337', '023818', '047192')
```
15. Click Run from the Toolbar.

16. Ctrl-click in the Net Amount and Average Amount per Travel Expense Record columns, and all of the Total cells for those columns to highlight them all.

17. Click on the Data Format icon in the Toolbar. In the window that opens, change the Format type to Currency to improve readability.

18. Save the report specification as Aggregation.
19. Click Run Report from the Toolbar:

<table>
<thead>
<tr>
<th>Person Entity Identifier – PID</th>
<th>Name</th>
<th>Fiscal Year</th>
<th>Account Number</th>
<th>Travel Expense Record Count</th>
<th>Not Amount</th>
<th>Average Amount per Travel Expense Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>011337</td>
<td>ORR, EDDE</td>
<td>2008</td>
<td>150008</td>
<td>15</td>
<td>$5,004.79</td>
<td>$333.65</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>150011</td>
<td>16</td>
<td>$5,317.54</td>
<td>$332.35</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>150022</td>
<td>12</td>
<td>$2,808.06</td>
<td>$234.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>150953</td>
<td>4</td>
<td>$885.69</td>
<td>$221.42</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>150954</td>
<td>19</td>
<td>$5,764.70</td>
<td>$303.41</td>
</tr>
<tr>
<td>2008 - Summary</td>
<td></td>
<td></td>
<td></td>
<td>66</td>
<td>$49,280.77</td>
<td>$799.74</td>
</tr>
<tr>
<td>2009</td>
<td></td>
<td></td>
<td>150008</td>
<td>14</td>
<td>$4,715.54</td>
<td>$336.82</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>150011</td>
<td>24</td>
<td>$8,075.08</td>
<td>$336.46</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>150022</td>
<td>46</td>
<td>$6,035.97</td>
<td>$131.22</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>150954</td>
<td>28</td>
<td>(816.95)</td>
<td>(29.18)</td>
</tr>
<tr>
<td>2009 - Summary</td>
<td></td>
<td></td>
<td></td>
<td>112</td>
<td>$18,009.64</td>
<td>$163.68</td>
</tr>
<tr>
<td>2010</td>
<td></td>
<td></td>
<td>150011</td>
<td>5</td>
<td>$1,952.63</td>
<td>$390.53</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>150022</td>
<td>49</td>
<td>$10,720.49</td>
<td>$218.79</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>290001</td>
<td>20</td>
<td>$7,700.25</td>
<td>$385.10</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>290003</td>
<td>7</td>
<td>$13,067.56</td>
<td>$1,823.93</td>
</tr>
<tr>
<td>2010 - Summary</td>
<td></td>
<td></td>
<td></td>
<td>81</td>
<td>$33,605.93</td>
<td>$413.63</td>
</tr>
<tr>
<td>011337 - Summary</td>
<td></td>
<td></td>
<td></td>
<td>259</td>
<td>$71,284.34</td>
<td>$275.27</td>
</tr>
<tr>
<td>022818</td>
<td>MCCRAY, SHeldon</td>
<td>2008</td>
<td>121660</td>
<td>8</td>
<td>$2,010.99</td>
<td>$251.37</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>123012</td>
<td>5</td>
<td>$505.53</td>
<td>$101.11</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>123682</td>
<td>8</td>
<td>$3,018.13</td>
<td>$377.27</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>123685</td>
<td>6</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>123686</td>
<td>3</td>
<td>$1,002.33</td>
<td>$334.11</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>195001</td>
<td>1</td>
<td>$45.45</td>
<td>$45.45</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>195003</td>
<td>5</td>
<td>$1,313.89</td>
<td>$262.78</td>
</tr>
<tr>
<td>2008 - Summary</td>
<td></td>
<td></td>
<td></td>
<td>36</td>
<td>$7,076.32</td>
<td>$221.66</td>
</tr>
</tbody>
</table>
Now assume that we want to forecast the impact of an expected increase in Net Amount for specific IFAS Fund Source Codes of 25% and a decrease of 10% for all other fund source codes.

1. Click on the New icon in the Toolbar to launch a new report.

2. Create a new List report using the **UCAR Training** package.

3. From the CPM Training Data namespace, General Ledger namespace, Account query subject, add the following query items to the report page:
   - Lab Code
   - Division_Program Code
   - IFAS Fund Source Code

4. From the General Ledger Details query subject, add the Net Amount query item to the report.

5. Add the following Advanced Detail Filters as shown:

   ```
   Expression Definition:
   [General Ledger].[Date].[Fiscal Year] = 2010
   ```

   ```
   Expression Definition:
   [General Ledger].[Account].[Entity Code] = 'NCAR'
   ```

   ```
   Expression Definition:
   [General Ledger].[Account].[Status] = 'A'
   ```

7. Add a new Query Calculation to the end of the report named “Forecast” and select Other expression.
8. Use the Functions tab to find the format for an “if then else” statement construct.
   - Your expression effectively says that if IFAS Fund Source Code is NFSRGC or NSFRCORE, calculate [Net Amount] * 1.25, otherwise calculate [Net Amount] * .9.
   - Note: Make use of the Tips box for syntax.

10. Use the Aggregate icon from the Toolbar to add a Total line for Net Amount and Forecast.
11. Save the report specification as Aggregation - Conditional Calculation.
NOTE

When selecting specific values for a data item, it is good practice to use the Select Value or Select Multiple Values icons in the top right of the Data Item Expression window. This is another way to help to avoid typing errors in your expression.

12. Click Run Report from the Toolbar:
Chapter 4 – The Query Model

In Report Studio, the report page and the underlying queries control the format and the output of a report. In the previous chapters, we created list reports by dragging and dropping data items onto the report page. As we were doing this, Report Studio was automatically building the “query” that actually retrieves the data from the data source in the background. The query contains all of the data items, as well as any filters or aggregations that have been applied. Let’s review what we did in previous chapters to learn more about the query model.

Step-By-Step

Examine the Query Model

1. Open your **Totals** report specification (from Chapter 2).
2. Mouse over the Explorer bar to discover what the query definition looks like – click on Query1.
3. Scroll to note all of the properties associated with the Query itself.

When we created the filters on the report page, we used the Filters icon in the Toolbar, and clicked on the Detail tab in the filter window. Note that the filter icon is disabled in the Query Explorer, but the same filters are defined in the Detail Filters window.

4. Return to the report page by mousing over the Page Explorer to choose the appropriate page.
Chapter 4 – The Query Model

Cut vs. Delete

5. Back in the report page, highlight Post Date, and click on the Cut icon in the Toolbar.
6. Highlight Medium Description and click on the Delete icon in the Toolbar.
7. Use the Query Explorer to return to Query1.
8. Note that Medium Description has been removed from the Query, but the Post Date data item was not.

9. Use the Back arrow to again return to the report page.
10. Click on the Undo arrow to return Medium Description to the report page.
11. Click on the Undo arrow again to return Post Date to the report page.

There are many scenarios where you may want to keep or add a data item to the query, but not necessarily reflect that item on the report page.
In this exercise we create a report by first “hand-crafting” the Query instead of producing it by way of dragging and dropping columns onto a report page.

1. Click on the New icon in the Toolbar to launch a new report.

2. Choose Blank and click OK (We have not utilized the Blank report style thus far).

3. Mouse over the Query Explorer and note that this report does not have an included query at this point. You may recall that all other report formats begin with a default, yet empty, query called Query1.

4. Navigate to the Queries folder using the Query Explorer.
5. Drag a new Query object into the Queries folder from the Toolbox. It is given the default name Query1.

6. Highlight the query and rename it by modifying the Name property to “Report Data”.


8. From the CPM Training Data namespace, General Ledger namespace, Person query subject, drag the following query items to the Data Items panel:
   - Person Entity Identifier – PEID
   - Name

9. From the General Ledger Details query subject, add the following query items:
   - Document Id
   - Net Amount
10. Highlight Document Id and in the Properties, change the Pre-Sort property to *Sort ascending*.

![Properties - Data Item](image)

11. Create a filter by dragging the Person Entity Identifier- PEID query item into the Detail Filters panel and completing the expression as shown:

   **Expression Definition:**
   
   \( [\text{Person Entity Identifier - PEID}] = '011337' \)

12. Let’s create a second filter to limit our results to travel-related expenses. Drag Object Code from the Source tab, General Ledger Details query subject, and complete the expression as shown:

   **Expression Definition:**
   
   \( [\text{General Ledger}],[\text{General Ledger Details}],[\text{Object Code}] \) starts with '54'

We created an expression on the report page by dragging a Query Calculation from the Toolbar. In the Query model, we use the Data Item object from the Toolbox.
13. Drag a new Data Item into the Data Items window, complete the expression as follows, and then Validate the expression.

14. In the Properties, rename the item to “Document Count”.
15. Change the Aggregate Function to Total.
16. Select the Document Id data item, and change the Label property to “Travel Document ID”. Notice that changing the Label does not change the Name of the query item.

Auto Group & Summarize

By default, IBM Cognos automatically summarizes and aggregates data at the lowest level of detail in the query. This behavior is controlled by the Auto Group & Summarize property in the Query.

To demonstrate this functionality, we make use of the View Tabular Data option in the Query model. This option allows you to effectively “run” your query in order to preview the data that is being returned.

17. Ensure that your Query object is selected by clicking in the white space between the Data Items panel and the Explorer Bar.
18. Select **View Tabular Data** from the Run menu to preview the query as shown.

The data is displayed in a “tabular” list, without any of the grouping or formatting that may have been applied on the report page.

19. Next, change the Auto Group & Summarize property to **No**.
20. Again select to **View Tabular Data** from the Run menu.

![Table](image)

The query is now returning every row of detail from the database, without any grouping or aggregation.

21. Set Auto Group and Summarize back to **Yes**.

**NOTE**

For most reports, the Auto Group and Summarize property is set to **Yes**. However, when troubleshooting a report that is returning unexpected results, it is often useful to temporarily change the property to **No** in order to analyze the underlying detail.
Generate the SQL

When a report is run in Report Studio or IBM Cognos Connection, IBM Cognos is using all of the building blocks of the report page and the query (data items, filters, and formatting) to generate a Structured Query Language (SQL) statement. If you are familiar with SQL, analyzing the statement can be another useful tool when troubleshooting a report.

22. In the Query properties, click the ellipse in the Generated SQL property.

You receive the following warning (Click OK):

```
This dialog will NOT show the SQL that is generated for the report.
It will show the SQL for a tabular representation of the query data items. This may also return errors if the query is against a multi-dimensional data source or contains calculations that reference grouped items.

Like "Show Generated SQL/MX" from the Tools menu to see the SQL/MX that was generated for the report.
```

The SQL is displayed, with the option to show the “native” statement that is sent to the server, or the more easily interpreted “IBM Cognos” statement.
Chapter 4 – The Query Model

NOTE

You can also access the generated SQL by clicking on the Tools menu and selecting **Show Generated SQL/MDX**:

![Tools Menu Screenshot](image)

Add the Query to the Page

23. Navigate to Report Page1, and click the Filters Toolbar button, **Edit Filters** to view your filters.

24. From the Data Items tab, drag the query subject (Report Data) onto the blank page.
Chapter 4 – The Query Model

25. Save the report specification as **Query Models**.
26. Run the report.

Notice that IBM Cognos has automatically added all query items in the query in a basic List report.
Chapter 5 – Conditions and Filters

In the previous chapters we created several filters as part of the exercises. Filters are hard-coded conditions and values; the report user doesn’t get to select the values used for the conditions.

Filter Syntax Guidelines

Anything that is a character field requires single quotes around it. The IFAS Fund Source Code field we’ve been using is an example of that. Note, however, that fields that contain all numbers may be character fields in the database, e.g., Account Number. To check, you can right-click on the field and select Properties. This tells you key information about the Data type:

Example: Account Number = ‘160001’
Chapter 5 – Conditions and Filters

Character examples:

[IFAS Fund Source Code] starts with 'NSFR'
[IFAS Fund Source Code] like '%NSFR%'
[IFAS Fund Source Code] = ‘NSFRCORE’

Numeric fields do not require single quotes:

[Net Amount] > 1000
[Net Amount] in (1000, 5000)
[Net Amount] between 1000 and 2000

Dates:

[Post Date] = 2010-08-01
[Post Date] in_range {2010-08-01:2010-08-31}
[Post Date] between 2010-08-01 and 2010-08-31
[Post Date] in_range {2010-08-01T00:00:00.000: 2010-08-31T23:59:59.999}
[Post Date] in_range ?Date_Range?

Aggregate Filters

Most of the filtering that we have done so far has been at the Detail level. Typically 99% of report filters are applied at this level. However, sometimes you may wish to filter on values at grouped levels.

There are at least three levels of aggregation on which you can filter:

No Aggregation or Database Row
- Detail Filter with Application property set to “Before Auto Aggregation”
- This is the default Detail filter and the type we’ve used so far in this course.

Report Row
- Detail Filter with Application property set to “After Auto Aggregation”

Footer / Subtotal Row –
- Summary Filter with Scope property set to the grouping level (aka aggregation level) at which you wish to filter.
Step-By-Step

Using a Detail Filter

Let’s review the detail filter concept by starting with a new List report using the UCAR Training package.

1. Using the Query explorer, click on Query1.

2. From the Source tab, CPM Training Data namespace, General Ledger namespace, expand the Account query subject, and drag the following query items into the Data Items panel:
   - Account Number
   - Medium Title

3. Expand the Object Code query subject, and add the following query items:
   - Object Code
   - Medium Description

4. Expand the General Ledger Details query subject, and add the following query item:
   - Net Amount
5. Add the following Detail Filters:

- Expression Definition:
  \[ [\text{General Ledger}].[\text{Date}].[\text{Fiscal Year}] = 2010 \]

- Expression Definition:
  \[ [\text{General Ledger}].[\text{Date}].[\text{Fiscal Year Quarter}] = 1 \]

- Expression Definition:
  \[ [\text{Account Number}] \text{ starts with '16000'} \]

6. Return to the report page.
7. From the Source tab, open the Account query subject and add the Account Number query item to the list report.

Note that the number 1 has been added to the end of the item.

8. Click on the Undo icon.
9. From the Data Items tab, add query items as shown:

<table>
<thead>
<tr>
<th>Account Number</th>
<th>Medium Title</th>
<th>Object Code</th>
<th>Medium Description</th>
<th>Net Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Account Number&gt;</td>
<td>&lt;Medium Title&gt;</td>
<td>&lt;Object Code&gt;</td>
<td>&lt;Medium Description&gt;</td>
<td>&lt;Net Amount&gt;</td>
</tr>
<tr>
<td>&lt;Account Number&gt;</td>
<td>&lt;Medium Title&gt;</td>
<td>&lt;Object Code&gt;</td>
<td>&lt;Medium Description&gt;</td>
<td>&lt;Net Amount&gt;</td>
</tr>
<tr>
<td>&lt;Account Number&gt;</td>
<td>&lt;Medium Title&gt;</td>
<td>&lt;Object Code&gt;</td>
<td>&lt;Medium Description&gt;</td>
<td>&lt;Net Amount&gt;</td>
</tr>
</tbody>
</table>

You see this or subsequent numbers when a data item has been added more than once to the page or source query.

10. Group on Account Number.
11. Group Span Medium Title based on Account Number.
13. Run the report.

<table>
<thead>
<tr>
<th>Account Number</th>
<th>Medium Title</th>
<th>Object Code</th>
<th>Medium Description</th>
<th>Net Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>160001</td>
<td>MMM Science</td>
<td>5260</td>
<td>Mat-General</td>
<td>24.87</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5274</td>
<td>Cafe Food-Matria</td>
<td>310</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5281</td>
<td>Computer &lt;5K</td>
<td>1,800</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5320</td>
<td>Computer Sftwre</td>
<td>197.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5324</td>
<td>Comp Maintenance</td>
<td>359</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5350</td>
<td>Freight</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5355</td>
<td>Overnt&amp;Expr Mail</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5363</td>
<td>Conference Svcs</td>
<td>5.57</td>
</tr>
</tbody>
</table>

Next, assume that we only want to include the Object Code values with a Net Amount greater than 100.

14. Add a new Advanced Detail Filter as shown:

   Expression Definition:
   
   \[[\text{Net Amount}] > 100\]

15. Run the report.

<table>
<thead>
<tr>
<th>Account Number</th>
<th>Medium Title</th>
<th>Object Code</th>
<th>Medium Description</th>
<th>Net Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>160001</td>
<td>MMM Science</td>
<td>5274</td>
<td>Cafe Food-Matria</td>
<td>310</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5281</td>
<td>Computer &lt;5K</td>
<td>1,800</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5320</td>
<td>Computer Sftwre</td>
<td>153.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5324</td>
<td>Comp Maintenance</td>
<td>359</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5420</td>
<td>Dom Per Diem-$26</td>
<td>373</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5430</td>
<td>Lodging Domestic</td>
<td>616.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5473</td>
<td>Registration Fee</td>
<td>410</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5711</td>
<td>Overhead</td>
<td>1,692.55</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5712</td>
<td>Overhead</td>
<td>156.95</td>
</tr>
<tr>
<td>160002</td>
<td>Journal Page Chr</td>
<td>5239</td>
<td>Publication Pgs</td>
<td>4,060</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5711</td>
<td>Overhead</td>
<td>1,890.36</td>
</tr>
</tbody>
</table>

Why didn’t the report return the same Computer Software Net Amount, for example, that we saw in the previous report run?
16. Click on the Filter icon, **Edit Filters**, and disable the Net Amount filter, as shown:

![Image of Filter Icon]

Note that the filter icon becomes grayed out in the window.

17. Using the Query explorer, open Query1.

18. In the Query properties, change the Auto Group & Summarize property to **No**.

![Image of Query Properties]
19. Save the report as **Detail Filter**.
20. Run the report.

The filter is being applied at the *database row level*, and excludes all of the individual transactions that are less than 100.
Chapter 5 – Conditions and Filters

Step-By-Step

Using a Report Row Filter

Continue with the previous exercise, but assume that now it is our intention to reflect Net Amounts when the total amount for each Object Code (within each Account Number) is greater than 100.

1. In Query1, change the Auto Group & Summarize property back to Yes.
2. Edit the Net Amount filter by highlighting it, and changing the Usage property to Required.
3. Change the Application property to After Auto Aggregation.

5. Run your report and note that Object Code is being filtered at the aggregated report row level rather than the database row level.
Chapter 5 – Conditions and Filters

These totals include ALL individual Object Code values from the database detail, including those with amounts less than or equal to 100.

<table>
<thead>
<tr>
<th>Account Number</th>
<th>Medium Title</th>
<th>Object Code</th>
<th>Medium Description</th>
<th>Net Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>160001</td>
<td>MMM Science</td>
<td>5274</td>
<td>Cafe Food-Matrix</td>
<td>310</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5281</td>
<td>Computer &lt;5K</td>
<td>1.800</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5320</td>
<td>Computer Sftwre</td>
<td>197.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5324</td>
<td>Comp Maintenance</td>
<td>359</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5401</td>
<td>Domestic Travel</td>
<td>159.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5420</td>
<td>Dom Per Diem-$26</td>
<td>266.33</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5430</td>
<td>Lodging Domestic</td>
<td>416.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5473</td>
<td>Registration Fee</td>
<td>350</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5711</td>
<td>Overhead</td>
<td>1,846.08</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5712</td>
<td>Overhead</td>
<td>189.6</td>
</tr>
<tr>
<td>160002</td>
<td>Journal Page Chr</td>
<td>5239</td>
<td>Publication Pgs</td>
<td>3,850</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5711</td>
<td>Overhead</td>
<td>1,890.35</td>
</tr>
</tbody>
</table>

NOTE
To further clarify this concept, when your filter is set to be applied Before Auto Aggregation, IBM Cognos filters the detail rows, then adds up the measure. When it is set to After Auto Aggregation, IBM Cognos summarizes the measure first, then applies the filter.
If you choose the Create Custom Filter option:

The IBM Cognos default is to apply the filter After auto aggregation.
Step-By-Step

**Using a Summary Filter**

1. Start with the **Report Row Filter** exercise.
2. Disable the Net Amount filter (change the Usage property to **Disabled**).
3. Return to the report page.
4. From the General Ledger Details query subject, insert Post Date in between Medium Description and Net Amount.
5. Group the Object Code column and apply a group span to Medium Description based on Object Code.
6. From the Toolbar, apply a Total aggregate to Net Amount.
7. Run the report.

<table>
<thead>
<tr>
<th>Account Number</th>
<th>Medium Title</th>
<th>Object Code</th>
<th>Medium Description</th>
<th>Post Date</th>
<th>Net Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>160001</td>
<td>MMM Science</td>
<td>5260</td>
<td>Mat-General</td>
<td>Nov 30, 2009 12:00:00 AM</td>
<td>7.53</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Dec 21, 2009 12:00:00 AM</td>
<td>2.17</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Dec 31, 2009 12:00:00 AM</td>
<td>15.17</td>
</tr>
<tr>
<td>5260 - Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>24.87</td>
</tr>
<tr>
<td>5274</td>
<td>Cafe Food-Matri</td>
<td></td>
<td></td>
<td>Dec 22, 2009 12:00:00 AM</td>
<td>310</td>
</tr>
<tr>
<td>5274 - Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>310</td>
</tr>
<tr>
<td>5281</td>
<td>Computer &lt;5K</td>
<td></td>
<td></td>
<td>Dec 22, 2009 12:00:00 AM</td>
<td>1.800</td>
</tr>
<tr>
<td>5281 - Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1.800</td>
</tr>
<tr>
<td>5320</td>
<td>Computer Sftwre</td>
<td></td>
<td></td>
<td>Dec 17, 2009 12:00:00 AM</td>
<td>197.1</td>
</tr>
<tr>
<td>5320 - Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>197.1</td>
</tr>
<tr>
<td>5324</td>
<td>Comp Maintenance</td>
<td></td>
<td></td>
<td>Dec 22, 2009 12:00:00 AM</td>
<td>359</td>
</tr>
<tr>
<td>5324 - Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>359</td>
</tr>
<tr>
<td>5350</td>
<td>Freight</td>
<td></td>
<td></td>
<td>Dec 17, 2009 12:00:00 AM</td>
<td>9</td>
</tr>
<tr>
<td>5350 - Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>9</td>
</tr>
<tr>
<td>5355</td>
<td>Overml&amp;Expr Mail</td>
<td></td>
<td></td>
<td>Oct 1, 2009 12:00:00 AM</td>
<td>-5.02</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Oct 16, 2009 12:00:00 AM</td>
<td>5.02</td>
</tr>
<tr>
<td>5355 - Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0</td>
</tr>
<tr>
<td>5363</td>
<td>Conference Svecs</td>
<td></td>
<td></td>
<td>Dec 21, 2009 12:00:00 AM</td>
<td>5.57</td>
</tr>
<tr>
<td>5363 - Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5.57</td>
</tr>
</tbody>
</table>
Chapter 5 – Conditions and Filters

Now assume that we only want the report to include those Object Codes where the summary row for Net Amount exceeds 200.

8. Click on the Filters icon, **Edit Filters**, and this time, click on the Summary Filters tab.
10. In the filter window, note the option to define the Scope:

![Usage window with options: Required, Optional, Disabled. Scope field is highlighted.]

Given that there may be multiple grouping levels in a report, you must define at what grouping level you want to apply the summary filter.

11. Click on the ellipse and select Object Code.

![Scope window with Object Code option selected.]

12. Click OK twice.
13. Save the report as **Summary Row Filter**.
14. Run the report to show that only Object Codes where the Summary row Net Amount total is greater than 200 are returned.

<table>
<thead>
<tr>
<th>Account Number</th>
<th>Medium Title</th>
<th>Object Code</th>
<th>Medium Description</th>
<th>Post Date</th>
<th>Net Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>160001</td>
<td>MMM Science</td>
<td>5274</td>
<td>Cafe Food-Matris</td>
<td>Dec 22, 2009 12:00:00 AM</td>
<td>310</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5274 - Total</td>
<td></td>
<td></td>
<td>310</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5281</td>
<td>Computer &lt;5K</td>
<td>Dec 22, 2009 12:00:00 AM</td>
<td>1,800</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5281 - Total</td>
<td></td>
<td></td>
<td>1,800</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5324</td>
<td>Comp Maintenance</td>
<td>Dec 22, 2009 12:00:00 AM</td>
<td>359</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5324 - Total</td>
<td></td>
<td></td>
<td>359</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5420</td>
<td>Dom Per Dem-$26</td>
<td>Oct 1, 2009 12:00:00 AM</td>
<td>-106.67</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5420 - Total</td>
<td></td>
<td></td>
<td>266.33</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5430</td>
<td>Lodging Domestic</td>
<td>Oct 1, 2009 12:00:00 AM</td>
<td>-200</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5430 - Total</td>
<td></td>
<td></td>
<td>416.2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5473</td>
<td>Registration Fee</td>
<td>Nov 30, 2009 12:00:00 AM</td>
<td>410</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5473 - Total</td>
<td></td>
<td></td>
<td>350</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5711</td>
<td>Overhead</td>
<td>Oct 31, 2009 12:00:00 AM</td>
<td>129.77</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5711 - Total</td>
<td></td>
<td></td>
<td>1,846.08</td>
</tr>
<tr>
<td>160001 - Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5,347.61</td>
</tr>
</tbody>
</table>
15. Use the Query Explorer to open Query1 to examine the Query model.

<table>
<thead>
<tr>
<th>Data Items</th>
<th>Detail Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Number</td>
<td>[General Ledger].[Date].[Fiscal Year] = 2010</td>
</tr>
<tr>
<td>Medium Title</td>
<td>[General Ledger].[Date].[Fiscal Year Quarter] = 1</td>
</tr>
<tr>
<td>Object Code</td>
<td>[Account Number] starts with '16000'</td>
</tr>
<tr>
<td>Medium Description</td>
<td>[Net Amount] &gt; 100</td>
</tr>
<tr>
<td>Net Amount</td>
<td></td>
</tr>
<tr>
<td>Post Date</td>
<td></td>
</tr>
<tr>
<td>Total(Net Amount)</td>
<td></td>
</tr>
</tbody>
</table>

| Summary Filters    |                                                                               |
|--------------------|                                                                               |
| [Net Amount] > 200 |                                                                               |

**NOTE**

If you're familiar with SQL, filtering at the Detail level is like adding a condition in your WHERE clause. Filtering at the Summary level is like adding a condition in your HAVING clause.

**NOTE**

To troubleshoot errors after validating your report, highlight only the first error, and click Error Details to view the error. Resolve that issue and re-validate before proceeding to any other errors.
AND / OR Statements

AND statements mean that all defined conditions must be met in order for the data to be included in the query results.

In the example below the only results that would print on our report would be for Fiscal Year 2010 for Object Code 5101 with Net Amounts greater than 500.

OR Statements mean that the defined conditions can include multiple results. The defined conditions must be met in order to be included in the query results.

In the example below the results that would print in our report would be transactions within Fiscal Year 2010 with either Object Code = 5101 or Net Amount > 500.
1. Start with your **Totals** report (from Chapter 2).
2. Edit your Net Amount filter using the “and” operator as shown:

```
Expression Definition:
[Object Code] = '5101'
AND
[Net Amount] > 800
```

3. Click Run Report from the Toolbar to note that ALL filter conditions have been met.

![Report Table]

4. Now change the new filter to use an ‘OR’ condition instead of ‘AND’.
5. Change the Sort on Object Code to **Ascending**.
Chapter 5 – Conditions and Filters

6. Click Run Report from the Toolbar again to notice that your report now has more records, and contains records where either the Object Code is 5101 OR the Net Amount is greater than 800.

<table>
<thead>
<tr>
<th>Account Number</th>
<th>Medium Title</th>
<th>Object Code</th>
<th>Medium Description</th>
<th>Post Date</th>
<th>Net Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>160004</td>
<td>MMM Fid. Proc. Su</td>
<td>1225</td>
<td>Reimb Trvl Rec</td>
<td>Jul 15, 2010 12:00:00 AM</td>
<td>4,892.21</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Aug 23, 2010 12:00:00 AM</td>
<td>8,501.11</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Sep 1, 2010 12:00:00 AM</td>
<td>9,784.42</td>
</tr>
<tr>
<td>1225 - Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>23,177.74</td>
</tr>
<tr>
<td>5081</td>
<td>Phd Sci-Other Py</td>
<td></td>
<td></td>
<td>Jul 30, 2010 12:00:00 AM</td>
<td>1,448.75</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Aug 13, 2010 12:00:00 AM</td>
<td>1,265.75</td>
</tr>
<tr>
<td>5081 - Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2,714.5</td>
</tr>
<tr>
<td>5101</td>
<td>Full Benefits</td>
<td></td>
<td></td>
<td>Jul 30, 2010 12:00:00 AM</td>
<td>751.9</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Aug 13, 2010 12:00:00 AM</td>
<td>656.93</td>
</tr>
<tr>
<td>5101 - Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1,408.83</td>
</tr>
<tr>
<td>5260</td>
<td>Mat-General</td>
<td></td>
<td></td>
<td>Oct 15, 2009 12:00:30 AM</td>
<td>3,184.96</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Nov 6, 2009 12:00:00 AM</td>
<td>970.5</td>
</tr>
</tbody>
</table>

7. Save the report specification as **OR Filter**.

Let's look at an alternative way of setting up this same filter.
Chapter 5 – Conditions and Filters

**Step-By-Step**

*Add a Combined Filter*

1. Start with your **Totals** report again (from Chapter 2).
2. Select the Filters icon in the Toolbar and select **Edit Filters**.

3. Disable the Detail Filter on Net Amount.
4. Add a new Combined filter:

   ![Create Filter](image)

5. Choose to create the filter on Object Code and click OK.

   ![Create Filter](image)
6. Search for 5101 from the Object Codes, select it, click the green arrow to insert it into your Selected values list, and click OK.

7. Let's add another condition to this filter:
8. Select Net Amount from the drop-down, and click OK.

You now have a Combined AND filter:

9. Create a filter to Show only values greater than 800 and click OK.

You now have a Combined AND filter:
10. Click OK.
11. Return to your report page and run your report:

<table>
<thead>
<tr>
<th>Account Number</th>
<th>Medium Title</th>
<th>Object Code</th>
<th>Medium Description</th>
<th>Post Date</th>
<th>Net Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>160001</td>
<td>MMM Science</td>
<td>5101</td>
<td>Full Benefits</td>
<td>Feb 26, 2010 12:00:00 AM</td>
<td>2,092.74</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Jun 18, 2010 12:00:00 AM</td>
<td>812.96</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Jun 30, 2010 12:00:00 AM</td>
<td>1,054.52</td>
</tr>
</tbody>
</table>

12. Go back and edit your Combined Filter to report results for Object Codes 5101 OR Net Amounts greater than 800:

Combined Filter

[Object Code] includes ('5101') OR Net Amount > 800

13. Choose to apply this new combined filter Before auto aggregation:

14. Change the Sort on Object Code to **Ascending**.
15. Save the report specification as **Combined Filter**.
16. Run your report:

<table>
<thead>
<tr>
<th>Account Number</th>
<th>Medium Title</th>
<th>Object Code</th>
<th>Medium Description</th>
<th>Post Date</th>
<th>Net Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>160004</td>
<td>MMM Fd. Proc. Su</td>
<td>1225</td>
<td>Reimb Trvl Rec</td>
<td>Jul 15, 2010 12:00:00 AM</td>
<td>4,892.21</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Aug 23, 2010 12:00:00 AM</td>
<td>8,501.11</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Sep 1, 2010 12:00:00 AM</td>
<td>9,784.42</td>
</tr>
<tr>
<td>1225 - Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>23,177.74</td>
</tr>
<tr>
<td>5081</td>
<td>Phd Sci-Other Py</td>
<td></td>
<td></td>
<td>Jul 30, 2010 12:00:00 AM</td>
<td>1,448.75</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Aug 13, 2010 12:00:00 AM</td>
<td>1,265.75</td>
</tr>
<tr>
<td>5081 - Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2,714.5</td>
</tr>
<tr>
<td>5101</td>
<td>Full Benefits</td>
<td></td>
<td></td>
<td>Jul 30, 2010 12:00:00 AM</td>
<td>751.9</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Aug 13, 2010 12:00:00 AM</td>
<td>656.93</td>
</tr>
<tr>
<td>5101 - Total</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1,408.83</td>
</tr>
<tr>
<td>5260</td>
<td>Mat. General</td>
<td></td>
<td></td>
<td>Oct 15, 2009 12:00:00 AM</td>
<td>3,184.96</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Nov 6, 2009 12:00:00 AM</td>
<td>970.5</td>
</tr>
</tbody>
</table>

**Step-By-Step Prompts**

Prompts are filters that allow the report user to select the value for a condition. The first step is to create a **parameter**.

Example: [Entity Code] = ?EntityPrompt?

1. Create a new List report using the **UCAR Training** package.
2. From the Source tab, add the following data items from the CPM Training Data namespace, General Ledger namespace, Account query subject:
   - Entity Code
   - Lab Code
   - Division_Program Code
   - Division_Program Medium Description
   - IFAS Fund Source Code
3. Add Net Amount from the General Ledger Details query subject.
5. Group Span Division_Program Medium Description based on Division_Program Code.

7. Click the Filter button, **Edit Filters**. Add two Advanced Detail Filters as follows:

   - Expression Definition: `[General Ledger].[Date].[Fiscal Year] = 2010`

   - Expression Definition: `IFAS Fund Source Code in ?FundPrompt?`

8. Click Run Report from the Toolbar. Note that the distinct values of IFAS Fund Source Code are automatically listed in the “stock prompt form” that IBM Cognos creates:

![Prompt Form Example]

   - Now let’s say your intention was to let people search and select values. We’ll customize our prompt page.

9. Cancel the prompt.

10. Mouse over the Page Explorer and select Prompt Pages.

11. Drag Page from the Insertable Objects pane into the Prompt Pages pane.


13. Now that you have a blank prompt page, drag the Select & Search Prompt from the Toolbox onto the prompt page.
14. Since we already created our parameter, select Use existing parameter, choose the parameter you created – FundPrompt – and select Next.

15. Name your query as shown and click Finish:

16. Save the report specification as **Prompt**.
17. Click Run Report from the Toolbar.
Chapter 5 – Conditions and Filters

18. Type “NSF” and then click the Options hyperlink.
   a. Note the search options available.
   b. Select the Contains any of these keywords radio button.
   c. Click Search.
   d. Click Select all and Insert.
   e. Click Finish at the bottom of the page.
Chapter 5 – Conditions and Filters

Note that your report now shows records for only the Fund Codes selected.

<table>
<thead>
<tr>
<th>Entity Code</th>
<th>Lab Code</th>
<th>Division_Program Code</th>
<th>Division_Program Medium Description</th>
<th>IPAS Fund Source Code</th>
<th>Net Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCAR</td>
<td>CSL</td>
<td>13</td>
<td>SCD</td>
<td>NSFGRANT</td>
<td>-420,996.7</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>NSFRCORE</td>
<td>53,033.26</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>NSFRCGC</td>
<td>-53,033.20</td>
</tr>
<tr>
<td>23</td>
<td>IMAGE</td>
<td></td>
<td></td>
<td>NSFGRANT</td>
<td>86,469.08</td>
</tr>
<tr>
<td>73</td>
<td>CSL</td>
<td></td>
<td></td>
<td>NSFGRANT</td>
<td>134,352.64</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>NSFRCORE</td>
<td>134,352.64</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>NSFRCGC</td>
<td>5,019,052.31</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>NSFRCORE</td>
<td>12,108,063.36</td>
</tr>
<tr>
<td>DR</td>
<td>15</td>
<td>NCARDR</td>
<td></td>
<td>NSFGRANT</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>NSFRCORE</td>
<td>402,275.65</td>
</tr>
<tr>
<td>19</td>
<td>ASP</td>
<td></td>
<td></td>
<td>NSFRCORE</td>
<td>2,654,505.59</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>NSFRCORE</td>
<td>141,459.85</td>
</tr>
<tr>
<td>29</td>
<td>ISP</td>
<td></td>
<td></td>
<td>NSFGRANT</td>
<td>-25,433.37</td>
</tr>
</tbody>
</table>

**NOTE**

By default IBM Cognos uses “stock prompt pages” if the report creator only creates a parameter without defining a prompt page. These “stock prompt types” are configurable in Framework Manager per field.

**NOTE**

The manual steps we just followed can be done with one click of this Toolbar button: 🗄️.
Reminder: To open a particular report specification from IBM Cognos Connection, click the icon shown below.

---

**NOTE**

**Prompt Types**

*** Please watch the instructor do this exercise. You complete a similar exercise in the Report Studio Part 2 course.

1. Start with the **Prompt** exercise and go to Query1.
2. Disable the Fiscal Year filter.
3. Create a new prompt for Entity Code by dragging it from the Data Items panel and creating a detail filter in Query1:

   ```
   [Entity Code] in ?EntityPrompt?
   ```

4. Using Page Explorer, navigate to Prompt Page1 and add a Value Prompt on the prompt page, selecting this EntityPrompt as the existing parameter. Click Next.
5. Name your new query “EntityQuery”, and click Finish.
6. Highlight your new prompt. Set the Required property for this Value Prompt to **No**, the Multi-Select property to **Yes**; and set Select UI to **Check box group**.

![Properties - Value Prompt]

7. Return to Query1 to add another prompt parameter.
8. Create a new prompt for Post Date by dragging it from the Insertable Objects pane, Source tab, and creating a detail filter:

```plaintext
Expression Definition:

[General Ledger].[General Ledger Details].[Post Date] in_range ?DatePrompt?
```

9. Using Page Explorer, navigate to Prompt Page1 and add a Date Prompt on the prompt page. Select **DatePrompt** as the existing parameter. Click Finish.

10. Select your new prompt (DatePrompt) and set the Required, Multi-Select, and Select UI properties as shown here.

![Properties - Date Prompt]

11. From the Insertable Objects pane, drag a Field Set object from the Toolbox onto the prompt page, move your Fund Source Search & Select prompt into the field set, and add the label “IFAS Fund Source Code: ”.
Your prompt page now looks like this:

12. Select the IFAS Fund Source Code prompt and make that prompt optional in the Properties pane.
13. Using Query Explorer, select Query1 and from there, make the IFAS Fund Source Code and Entity prompts Usage property optional for each filter.

In order for a prompt to be optional, the Required property on the prompt object must be set to No AND the Usage property on the filter must be Optional. If either is set to Required, then the prompt is required.

The same applies to Multi-select. Your prompt must use the in condition and multi-select set to Yes or your prompt will not be multi-select.

Now we have three prompts for report users, one of which is required (Post Date), the others optional (IFAS Fund Source Code and Entity Code). Now let’s add to the footer on the report to show all the prompt values selected.

14. To begin, add a Text Item from the Toolbox to your Report Page1 report footer just after the date, and click OK to close the dialog box.
15. Highlight where it says Double Click to Edit Text, and in the properties of the Text Item change Source Type to Report Expression.

16. Click the ellipses to open the Report Expression window.
17. From the Parameters tab, drag each parameter into the Expression Definition box.
18. Then copy each and change to show the parameter name, and concatenate each together with a + sign as follows:

```
Expression Definition:
ParamName('EntityPrompt') +
ParamDisplayValue('EntityPrompt') +

ParamName('FundPrompt') +
ParamDisplayValue('FundPrompt') +

ParamName('Date Prompt') +
ParamDisplayValue('DatePrompt')
```

19. Save the report specification as **Prompt with Footer**.
20. Run the report.
21. For Entity, scroll to the bottom and select UCARF, UCAR, and NCAR; for Post Date, select Jan 1, 2010 through Dec 31, 2010; and then search for IFAS Fund Source Codes that start with “NSF”. Select all, and Insert.
22. Click Finish.
23. Make the footer more readable by concatenating a colon and space in the expression and a comma and “carriage returns” as shown:

```
Expression Definition:
' + ParamName('EntityPrompt') + ': ' +
ParamDisplayValue('EntityPrompt') + ' +
'
'
ParamName('FundPrompt') + ': ' +
ParamDisplayValue('FundPrompt') + ' +
'
'
ParamName('DatePrompt') + ': ' +
ParamDisplayValue('DatePrompt')
```
Parameter selections then display as shown:

Sep 4, 2011
EntityPrompt: UCARF, UCAR, NCAR
FundPrompt: NSFDPY, NSFSPC,
NSFGRANT, NSFHRPC, NSFRCGC,
NSF, NSFRPCORE, NSFHIAPR
DatePrompt: Between Jan 1, 2010 and
Dec 31, 2010

NOTE
Creating more prompts instead of hard coded filters allows users more flexibility in getting the information they need.
Chapter 6 – Report Design

Step-By-Step

Report Formatting (Aesthetics)

1. Open the **Aggregation** report from Chapter 3.
2. Change the Detail Filter on Fiscal Year to a prompt:

   ![Expression Definition](image)

<table>
<thead>
<tr>
<th>Expression Definition:</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Expression" /></td>
</tr>
</tbody>
</table>

3. Mouse over the Page Explorer, select Prompt Pages. Drag Page from the Insertable Objects pane into the Prompt Pages panel.
4. Double-click on Prompt Page1, drag a Value prompt from the Toolbox onto the prompt page, select this FiscalYearPrompt as the existing parameter. Click Next.
5. Name your new query “FiscalYearQuery” and click Finish.
6. Select your new prompt, and set the Select UI property as shown here:

   ![Properties Table](image)

<table>
<thead>
<tr>
<th>Properties - <strong>Value Prompt</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Properties Table" /></td>
</tr>
<tr>
<td>Display Value</td>
</tr>
<tr>
<td>Static Choices</td>
</tr>
<tr>
<td>Rows Per Page</td>
</tr>
<tr>
<td>Properties</td>
</tr>
<tr>
<td><strong>General</strong></td>
</tr>
<tr>
<td>Required</td>
</tr>
<tr>
<td>Multi-Select</td>
</tr>
<tr>
<td>Select UI</td>
</tr>
<tr>
<td>Auto-Submit</td>
</tr>
</tbody>
</table>
Chapter 6 – Report Design

7. On the report page, change the Person Entity Identifier - PEID column title to “Person Entity Identifier”.
   a. Single-click the List Column Title and change the Source Type from Data Item Label to Text.
   b. Click the ellipsis in the new Text property, and type the new title in the window.

8. Highlight the Average Amount per Travel Expense Record summary rows and change the Horizontal alignment to Left.

Another formatting option is to add borders to make the report more readable.

9. Ctrl-click all cells in the report and in the Properties pane click on the ellipsis next to Border.
10. Select the solid square in the Preview portion and click OK.

The Border property now shows the following:

<table>
<thead>
<tr>
<th>Person Entity Identifier</th>
<th>Name</th>
<th>Fiscal Year</th>
<th>Account Number</th>
<th>Travel Expense Record Count</th>
<th>Net Amount</th>
<th>Average Amount per Travel Expense Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>111337</td>
<td>CRR, EDDIE</td>
<td>2008</td>
<td>15</td>
<td>5004.79</td>
<td>333.65</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>11</td>
<td>5317.54</td>
<td>332.95</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>22</td>
<td>2888.65</td>
<td>234.00</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>55</td>
<td>885.69</td>
<td>221.42</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>54</td>
<td>5764.76</td>
<td>233.41</td>
<td></td>
</tr>
</tbody>
</table>

2008 - Summary
86 $19,780.77 $265.71

2009
| 150068 | 14 | $4,715.54 | 336.82 |
| 150011 | 24 | $8,075.06 | 330.46 |
| 150022 | 46 | $8,035.97 | 131.22 |
| 150594 | 28 | $(816.95) | (29.18) |

2009 - Summary
112 $18,099.64 $160.80

2010
| 150011 | 5  | $1,952.83 | 390.53 |
| 150022 | 49 | $10,720.49 | 218.79 |
| 200061 | 20 | $7,765.25 | 388.16 |
| 200063 | 7  | $13,067.56 | 1,888.93 |

2010 - Summary
81 $33,963.93 $413.63

| 63818 | MCCRAY, SHELDON | 2008 | 121460 | 8 | $2,510.98 | $251.37 |
|       |                |     | 123652 | 5 | $585.53  | $117.11 |
|       |                |     | 123662 | 8 | $2,010.13 | $277.27 |
|       |                |     | 123685 | 6 | $0.00    | $0.00  |
|       |                |     | 123686 | 3 | $1,092.33 | $334.11 |
|       |                |     | 150501 | 1  | $45.45   | $45.45 |
|       |                |     | 150503 | 5  | $1,313.88 | $262.78 |

2008 - Summary
36 $7,976.32 $221.66

NOTE: Formatting a column does not affect the formatting of the summary row for that column. You may Ctrl-click multiple items and format them together if you wish. **Hint:** If you have a more complicated report, you may want to start Ctrl-clicking from the bottom of the report to ensure that you highlight all of the summary rows.

NOTE: Formatting properties exist on various objects. Use the list column for the detail lines, but either the text item or the list cell for the summary lines. Always be aware to which object you’re applying property settings, as the property may be inherited by child objects.
Chapter 6 – Report Design

12. Change the Font properties of all summary row items. You may Ctrl-click multiple columns.

You can control the Font type, size, color, and other styles from the Toolbar.

13. Use the Foreground color property to change the font color to Red.

14. With your rows still highlighted, change the point size to 12, the weight to Bold, and Underline your summaries.
15. In the report footer, format the Date function.

16. Click the icon, select the Date format and select Full from the Date Style property.

NOTE
The Data Formatting shown above can be set in Framework Manager for each field and inherited in each new report.

Using Tables to Organize Page Objects

There are two primary formatting objects: blocks and tables. Blocks are a container object that allows a developer to control all formatting options for the contents of the block. Tables are also a container object and allow a developer to quickly and easily organize and control placement of objects on the report page.
Step-By-Step

Using Formatting Tables

1. Continuing from the above exercise, select the Page Header area. Check the Select Ancestor arrow to be sure that you don’t have just the title block selected.

2. Using the Table tool from the Toolbar, add a 3 x 3 (3 column, 3 rows) table to your Page Header area.
3. Drag the Report Title Block (check the Select Ancestor arrow to be sure you have the Block) into the middle center cell of your new table.
4. Drag an Image Object from the Toolbox into the left center cell of your table.
5. Set the URL property for this image to:
   
   https://fagrand.fanda.ucar.edu/cpmimages/ucar-logo-spellout-med.jpg

6. Double-click and edit the report title as you wish (“Travel Costs”).
7. Change the Report Title Font size to 16 pt.

Blocks do not allow for organizing data in rows and columns as tables do, but they do provide additional properties including:

- Margin
- Floating
- Visible
- Controlling overflow in Size & Overflow
Chapter 6 – Report Design

8. Assume that you want to add some space between the header and the report. Insert a Block at the end of the header table.

9. Highlight the block, and edit the Size and Overflow property to a Height of 30 pixels.
10. Save your report specification as Formatting Techniques.

Layout Calculations

Layout calculations are often used to add “run time” information to the report. For instance, you may wish to display the user’s prompt choices in the header of the report, or to display the report name or folder location.

Step-By-Step

1. Continuing from the above exercise, drag a Layout Calculation into the center lower cell of the table you added to the report header.

2. In the expression editor, go to the Parameters tab.
3. Create the expression shown below, by typing in text and concatenating the text you type with a parameter name that you drag in with the mouse.
Chapter 6 – Report Design

4. Ctrl-click the three cells in the center column of your table, and set the Horizontal Alignment property to **Center**.

![Properties - Table Cell](image)

5. Drag a new Layout Calculation into the lower left table cell, click on the Functions tab, and choose ReportName from the Report Functions folder of the Expression editor.

![Report Expression](image)

6. Click OK.

One more common use of the Layout Calculation is to add a row number to your report list object.

7. Drag a Layout Calculation from the Toolbox and add it as a column to the right end of your list.
8. From the Functions tab, Report Functions folder, choose RowNumber.
9. Format the RowNumber data item as a Number with no decimal places, and change the column title to “Row Number”.
10. Ctrl-click all cells in the Row Number column, and apply a border of 1 pt, solid line, black, to all sides.
11. Save the report specification again (**Formatting Techniques**).
Notice that when your report is run, each row (not footer) displays an incrementing row number:

### Travel Costs

**Fiscal Year:** 2008, 2009, 2010

<table>
<thead>
<tr>
<th>Report Entry Identifier</th>
<th>Name</th>
<th>Fiscal Year</th>
<th>Amount Number</th>
<th>Travel Expense Related Count</th>
<th>Not Amount</th>
<th>Average Amount per Travel Expense Related</th>
<th>Row Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>011337</td>
<td>CHRI, EDDIE</td>
<td>2008</td>
<td>1050000</td>
<td>15</td>
<td>$5,645.79</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>105001</td>
<td></td>
<td>2008</td>
<td>105001</td>
<td>18</td>
<td>$6,231.94</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>105002</td>
<td></td>
<td>2008</td>
<td>105002</td>
<td>12</td>
<td>$2,586.56</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>105003</td>
<td></td>
<td>2008</td>
<td>105003</td>
<td>4</td>
<td>$900.09</td>
<td></td>
<td>4</td>
</tr>
<tr>
<td>105004</td>
<td></td>
<td>2008</td>
<td>105004</td>
<td>15</td>
<td>$7,584.70</td>
<td></td>
<td>5</td>
</tr>
</tbody>
</table>

**2008 - Summary**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Total</th>
<th>$19,789.77</th>
<th>$239.71</th>
</tr>
</thead>
</table>

**2009 - Summary**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Total</th>
<th>$18,009.64</th>
<th>$160.80</th>
</tr>
</thead>
</table>

**2010 - Summary**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Total</th>
<th>$23,503.23</th>
<th>$413.63</th>
</tr>
</thead>
</table>

### Headers and Footers

Headers are typically used to introduce next sections of a report and footers are typically used to summarize the previous section. These often make longer reports much easier to read.

### Step-By-Step

**Additional Report Formatting – Grouping with Headers**

1. Start with your Aggregation report from Chapter 3.
2. Edit the title of your report to read: “Grouping with Headers”.
3. Run the report as it stands:

![Grouping with Headers Table]

Next we explore the technique of using list headers for grouped reports. List headers allow you to provide a much more defined grouping look and feel, and save horizontal space on reports.

4. From the menu on the report page, choose **Structure, Headers and Footers**, and **List Headers & Footers**...
5. In the window that appears, check the header for Person Entity Identifier – PEID.

6. Click OK to return to your report. Note that the header row has been added.

7. Now that you have a header row for Person Entity Identifier - PEID, we can remove the column from the report, since it has become redundant. Select the column, and cut it from the page.

8. Ensure that your report is “unlocked” by toggling the Lock icon in the Toolbar.

9. From the Toolbox, drag a Text Item into the Person Entity Identifier - PEID header, and drop it before the Person Entity identifier - PEID data item. Type “Person Entity Identifier: ” into the Text box. Be sure to insert a space after the colon to show separation.
10. Make sure that the Lock icon reflects that the cells are again locked.

11. Select the List Cell highlighted by the cursor above and make sure that the Class property is set to “List outer header cell”.

12. Select the Ancestor arrow, choose the List object and set the Column Titles property to “At start of details”.

13. Save the report specification as **Grouping with Headers**.
14. Run the report.

<table>
<thead>
<tr>
<th>Person Entity Identifier: 091337</th>
<th>Fiscal Year</th>
<th>Account Number</th>
<th>Travel Expense Record Count</th>
<th>Net Amount</th>
<th>Average Amount per Travel Expense Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>O'Re, Ede</td>
<td>2000</td>
<td>150000</td>
<td>10</td>
<td>$5,004.79</td>
<td>$333.05</td>
</tr>
<tr>
<td></td>
<td></td>
<td>150011</td>
<td>16</td>
<td>$5,317.54</td>
<td>$332.35</td>
</tr>
<tr>
<td></td>
<td></td>
<td>150022</td>
<td>12</td>
<td>$2,088.05</td>
<td>$174.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>150953</td>
<td>4</td>
<td>$885.69</td>
<td>$221.42</td>
</tr>
<tr>
<td></td>
<td></td>
<td>150954</td>
<td>9</td>
<td>$5,784.70</td>
<td>$334.11</td>
</tr>
<tr>
<td></td>
<td>2009</td>
<td>150000</td>
<td>14</td>
<td>$4,715.54</td>
<td>$336.62</td>
</tr>
<tr>
<td></td>
<td></td>
<td>150011</td>
<td>24</td>
<td>$0.075.00</td>
<td>$326.46</td>
</tr>
<tr>
<td></td>
<td></td>
<td>150022</td>
<td>46</td>
<td>$6,035.97</td>
<td>$131.22</td>
</tr>
<tr>
<td></td>
<td></td>
<td>150954</td>
<td>28</td>
<td>(819.95)</td>
<td>(29.18)</td>
</tr>
<tr>
<td></td>
<td>2009 - Summary</td>
<td>66</td>
<td>$15,780.77</td>
<td>$299.71</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2010</td>
<td>150011</td>
<td>5</td>
<td>$1,982.63</td>
<td>$396.53</td>
</tr>
<tr>
<td></td>
<td></td>
<td>150022</td>
<td>49</td>
<td>$10,720.49</td>
<td>$216.79</td>
</tr>
<tr>
<td></td>
<td></td>
<td>290001</td>
<td>20</td>
<td>$7,763.25</td>
<td>$388.16</td>
</tr>
<tr>
<td></td>
<td></td>
<td>290003</td>
<td>7</td>
<td>$13,097.56</td>
<td>$1,871.09</td>
</tr>
<tr>
<td></td>
<td>2010 - Summary</td>
<td>81</td>
<td>$23,603.92</td>
<td>$413.02</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Person Entity Identifier: 023818</th>
<th>Fiscal Year</th>
<th>Account Number</th>
<th>Travel Expense Record Count</th>
<th>Net Amount</th>
<th>Average Amount per Travel Expense Record</th>
</tr>
</thead>
<tbody>
<tr>
<td>McCray, Sheldon</td>
<td>2008</td>
<td>121460</td>
<td>8</td>
<td>$2,015.99</td>
<td>$251.57</td>
</tr>
<tr>
<td></td>
<td></td>
<td>123612</td>
<td>5</td>
<td>$585.53</td>
<td>$117.11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>122602</td>
<td>6</td>
<td>$2,015.13</td>
<td>$377.27</td>
</tr>
<tr>
<td></td>
<td></td>
<td>122605</td>
<td>6</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>123686</td>
<td>3</td>
<td>$1,082.32</td>
<td>$364.11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>195001</td>
<td>1</td>
<td>$45.45</td>
<td>$45.45</td>
</tr>
<tr>
<td></td>
<td></td>
<td>195003</td>
<td>5</td>
<td>$1,313.80</td>
<td>$262.78</td>
</tr>
<tr>
<td></td>
<td>2008 - Summary</td>
<td>36</td>
<td>$7,070.32</td>
<td>$201.58</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE**

Grouping a report is a prerequisite for adding Page Breaking. Since we have grouped by Person Entity Identifier - PEID we can indicate that we would like a Page Break for each Person Entity Identifier - PEID that is encountered when running the report.
Chapter 6 – Report Design

15. Mouse over the Page Explorer, click on Report Pages, and add a Page Set from Insertable Objects.

16. Highlight the new Page Set1, and in the Properties pane, change the Query property to Query1.
17. Click on the ellipsis in the Grouping & Sorting property.

18. Drag Person Entity Identifier - PEID to the Groups folder in the right pane and click OK.

Since we have a page break for each Person Entity Identifier, we can now put that value anywhere on the page since we know there should be only one unique value per page.

20. Return to your report page and drag a table into the Page Header (1 column, 2 rows).
21. Drag the report title block into the first row of the table and change the title to “Page Breaks”.
22. Unlock your report.
23. Ctrl-click the Person Entity Identifier text item and the Person Entity Identifier – PEID data item in your List Header, and copy and paste them into the second row of your table in the Page Header.

24. Save the report specification as **Page Breaks**.
25. Run the report. Page down to view the page breaks by Person Entity Identifier.

### Step-By-Step

#### Adding Header Pages

In this example, we continue with the previous report, which already is grouped with page breaks, and add a header page for each Person Entity Identifier – PEID that is encountered when running the report. The header page contains some basic explanatory information about the detail that is to follow.

2. Add a new Page from the Insertable Objects pane by dragging the Page icon underneath the existing Page1.
3. Rename this page “Header” by changing the Name property of the page. Be sure the page is added to the Detail Pages and not at the Page Set level. Notice the light blue lines showing the page placement.

4. Drag the new page above Page1.
5. Double-click on the Header page. You are taken to this new, blank page.
6. From the menu on the report page, choose Structure > Headers and Footers > Page Headers & Footers.
7. Check the boxes next to the Header and Footer to add them to your blank page.

8. Using the Page Explorer, navigate back to your original Page1.
9. Select the Page Header area and click the copy button on the Toolbar. If needed, use the Select Ancestor arrow to select the Page Header.
10. Return to your Header page, click on the page, and paste your header there.
11. Use the same process to copy the Page Footer from the original page to your new page.
12. Drag a new table object into the center of your new page (2 X 2).
13. Ctrl-click the top two cells of your table and merge them.
14. In the new merged cell, add a Text Item (“For Person Entity Identifier: ”).
15. In the lower right cell, drag in the Person Entity Identifier - PEID item from your Data Items tab.
16. Run your report. Note that for each Person Entity Identifier encountered, there is a header page, which could include more detail.

17. Select the Header row on your report (Page1 – use the Select Ancestor arrow to be sure you have selected the List Header). Note the Pagination property allows you to repeat this header row in cases where the detail data for any given grouping level (Person Entity Identifier in this case) extends to additional pages.

![Pagination properties](image)

18. Save the report specification as **Header Page**.

**Demo**

**Using Create Sections for Grouping**

Similar to the “Build a Prompt Page” icon we learned about previously, Create Sections is a shortcut to create a list header. This icon saves the developer the step of grouping on the field manually, but sets a different class (for formatting) to the list header as we’ll see in this demo.

Next we demonstrate the use of sections to create a header row for each Violation Type.

1. Start with the **Prompt** report from Chapter 5.
2. Sort Entity Code Ascending.
3. Edit the title of your report: “Net Amount by Entity”.
4. Select the Entity Code column.
5. Click the Section button on the Toolbar (or choose **Structure > Section** from the Menu.).
6. Run the report to view the results. Search for values starting with ‘NSF’, Select all, Insert, and click Finish.

**Net Amount by Entity**

<table>
<thead>
<tr>
<th>Lab Code</th>
<th>Division_Program Code</th>
<th>Division_Program Medium Description</th>
<th>IFAS Fund Source Code</th>
<th>Net Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>CISL</td>
<td>13</td>
<td>SCD</td>
<td>NSFGRANT</td>
<td>-420,986.7</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NSFRCORE</td>
<td>53,033.26</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NSFRGC</td>
<td>-53,033.26</td>
</tr>
<tr>
<td></td>
<td>23</td>
<td>IMAGE</td>
<td>NSFGRANT</td>
<td>86,469.08</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NSFRCORE</td>
<td>86,469.08</td>
</tr>
<tr>
<td></td>
<td>73</td>
<td>CISL</td>
<td>NSFGRANT</td>
<td>134,352.64</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NSFRCORE</td>
<td>18,439,930.03</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NSFRGC</td>
<td>5,019,052.31</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NSFSPEC</td>
<td>12,108,063.36</td>
</tr>
<tr>
<td>DIR</td>
<td>15</td>
<td>NCARDIR</td>
<td>NSFGRANT</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NSFRCORE</td>
<td>402,276.95</td>
</tr>
<tr>
<td></td>
<td>19</td>
<td>ASP</td>
<td>NSFRCORE</td>
<td>2,664,505.59</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NSFSPEC</td>
<td>141,459.85</td>
</tr>
<tr>
<td></td>
<td>29</td>
<td>ISP</td>
<td>NSFGRANT</td>
<td>-25,433.37</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NSFRCORE</td>
<td>538,204.77</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NSFSPEC</td>
<td>114,203.03</td>
</tr>
<tr>
<td>EOL</td>
<td>14</td>
<td>ATD</td>
<td>NSFHIAPR</td>
<td>164,248.42</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NSFSPEC</td>
<td>145.51</td>
</tr>
<tr>
<td></td>
<td>74</td>
<td>EOL</td>
<td>NSFDPDY</td>
<td>4,314,380.19</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NSFGRANT</td>
<td>197,604.61</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NSFHIAPR</td>
<td>422,747.61</td>
</tr>
</tbody>
</table>

7. Save the report specification as **Grouping with Sections**.
The Class assigned to our Entity Code header is Section header cell. If we created it manually as a list header it would have been a List Inner Header Cell. These are just formatted a little differently out of the box.
Chapter 7 – Presenting Data Graphically

In this chapter we present how to create graphs and charts, including various chart styles and options, adding context to charts and using custom chart palettes.

Creating Various Chart Layouts

Step-By-Step

Creating a Simple Column or Bar Chart

1. Create a new Chart report using the UCAR Training package.

![Chart Report Creation](image)

2. Select the first Column style from the available choices and click OK.
3. Select the Page Body and align the chart Horizontal Center and Vertical Middle.
4. From the CPM Training Data namespace, General Ledger namespace, General Ledger Details query subject, drag Net Amount into the Default Measure (y-axis) drop-zone.
5. Drag Person Entity Identifier - PEID into the Categories (x-axis) drop-zone.
6. Sort Person Entity Identifier - PEID (Chart Node Member) ascending.
Chapter 7 – Presenting Data Graphically

7. Create two Advanced Detail Filters to restrict the data as shown:

   Expression Definition:
   [Person Entity Identifier - PEID] in ('011337', '023818', '047192')

   Expression Definition:
   [General Ledger].[General Ledger Details].[Object Code] starts with '54'

8. Run your report and note that we have a chart that examines a measure along a single dimension (the category).

   ![Chart](chart.png)

   Net Amount

   Person Entity Identifier - PEID

   011337   023818   047192

   9. From the Date query subject, drag Fiscal Year into the Series drop-zone.
   10. Sort Fiscal Year Ascending.
   11. Add the following Advanced Detail Filter:

       Expression Definition:
       [General Ledger].[Date].[Fiscal Year] <> 2011
12. Run your report again:

Now we have a chart that examines a measure along 2 dimensions, the Category of Person Entity Identifier - PEID, and the Series of Fiscal Year. In this example the Net Amount is displayed for each Person Entity Identifier - PEID and Fiscal Year for Object Codes that start with “54”.

13. From the menu, choose Structure > Swap Rows and Columns.
Chapter 7 – Presenting Data Graphically

14. Run your report again. Note that now we have Net Amounts displayed for each Fiscal Year, and then how it breaks down by Person Entity Identifier - PEID.

15. Leave the chart in the swapped mode.

Next we switch the chart from a Column to a Bar style. This is often preferable when there are many rows to display, since a chart can more easily grow vertically than horizontally.

16. From the menu, choose Structure > Convert Chart.
17. Select the first option from the Bar styles.

You may get the following message:

The following aspects of the original chart will not be copied to the new chart since they are no longer appropriate:
Chart Orientation
You can use Undo to return to the original chart.

18. Click OK.
19. In the **Series** box, click on the **Chart** icon to edit the Bar properties.

20. Set the **Values** property to **Show**.
21. Set the **Value Location** property to **Outside top**.
22. Run your chart again. Note that totals display for each Person Entity Identifier - PEID.
23. In the menu, choose **Structure > Lock Page Objects** to unlock your chart.
24. Select the Chart Body by clicking between the bars.
25. Change the **Font** property size to 7 points and run your chart.
26. Click on your chart (Combination Chart in the Select Ancestor arrow).
27. Change the Title property to Show and double-click in the newly created Chart Title to edit the text (“Travel Expenses by Fiscal Year”).
28. Change the Subtitle property to Show and double-click the new Chart Subtitle to edit the text (“By Person Entity Identifier”).
29. Expand the Axis titles box in the Chart Body.

30. Select the second axis title, change the Default Title property to No, then double-click to edit the title (“Travel Expense Net Amount”).

31. Change the Legend Title by clicking on Default Legend Title, change the Default Title property to No, and double-click the title to edit it (“Person Entity Identifier”).
32. Run your report:

### Travel Expenses by Fiscal Year

<table>
<thead>
<tr>
<th>Fiscal Year</th>
<th>2006</th>
<th>2007</th>
<th>2008</th>
<th>2009</th>
<th>2010</th>
</tr>
</thead>
<tbody>
<tr>
<td>Person Entity Identifier</td>
<td>011337</td>
<td>023616</td>
<td>047192</td>
<td>047192</td>
<td>011337</td>
</tr>
<tr>
<td>Travel Expense Net Amount</td>
<td>4,990.3</td>
<td>7,748.06</td>
<td>13,309.53</td>
<td>10,877.74</td>
<td>19,780.77</td>
</tr>
<tr>
<td>Travel Expense Net Amount</td>
<td>7,975.32</td>
<td>13,067.07</td>
<td>18,009.64</td>
<td>11,071.49</td>
<td>20,961.46</td>
</tr>
<tr>
<td>Travel Expense Net Amount</td>
<td>10,085.3</td>
<td>20,961.46</td>
<td>30,900.00</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

33. Convert the chart type from **Bar** to **Bar with 3-D Visual Effect**, this time by right-clicking in the chart and selecting **Convert Chart**. (Note that you receive the warning that certain chart properties will be reset again).
34. Click the Series icon again to change the Values property to **Hide**.

35. Run your report again. Your chart is rendered in a 3-D fashion and the display of values is removed.

An alternative to the above step would have been to set the Depth property of your original 1-D bar chart to some value > 0.

36. Save your report specification as **Chart – Simple**.
In this example we explore the use of **Pie Charts**, including single and multi-dimensional Pie Charts.

1. Begin with the previous report called **Chart–Simple**.
2. Convert the chart to a **Pie Chart**.
3. Delete Fiscal Year (make sure that you have the Chart Node Member selected) from **pies**.
4. Run your report and note that we have a Pie Chart that examines a measure along a single dimension (the Series).

5. Next undo Delete Fiscal Year from **pies**.
6. Edit the filter on Fiscal Year to show only Fiscal Years 2008, 2009, and 2010.
7. Swap Rows and Columns.
8. Set the Values property of your Pie Chart to **Outside slices with lines**.
9. Change the Font property of the Chart Body object to **11**.

![Pie Chart Example](image-url)
Chapter 7 – Presenting Data Graphically

Though it is not necessary for this exercise, you could change the Label property of the pies object (Chart Node).

10. Save your report specification as Chart – Pie.
11. Run your report. Note that we have allowed for one pie chart to be shown for each Person Entity Identifier - PEID.

Travel Expenses by Fiscal Year
By Person Entity Identifier

Person Entity Identifier - PEID

Step-By-Step
Creating Custom Chart Palettes

In this example we examine how to produce Custom Chart Palettes. Palettes refer to the set of colors used by Report Studio when producing a chart. Report Studio contains an internal standard palette, which continually uses the same colors in the same order when graphs are rendered. Report authors can override this color selection by choosing a custom chart palette.

1. Begin with the report called Chart – Pie.
2. Delete Person Entity Identifier -PEID from pies (Chart Node Member).
3. Set the Values Property of the Pie Chart to None.
4. Delete the Chart Subtitle.
5. Run your report to ensure it looks like this:

![Travel Expenses by Fiscal Year Chart]

This chart is calling on the standard internal color palette. The colors are used in the order you can observe in the legend for Selected Fiscal Years (i.e., Navy Blue, then Beige, then Maroon, and so forth).

6. Click on the Pie Chart object (the center of the chart).
7. Select the Palette property ellipse.
8. In the drop-down box, select **Gray Scale** from the Palette options provided by IBM Cognos.

9. Delete each of the Grey Scale colors and create a custom Palette by adding colors one at a time using the button. As you add each new color, choose **Color** rather than **Gradient** or **Pattern**.
10. To define each new color, click on the Color button and choose from the list of available colors.

11. Add 3 colors to your palette. You may reorder the palette colors using the arrow buttons if desired.
12. Change the Text Item under Series to read “Fiscal Year”:

13. Edit the filter on Fiscal Year to add the years 2006 and 2007.
14. Save your report specification as Chart–Palette.
15. Run your report again.

Note that your custom palette colors are utilized in the order you specified, and are then reused continually until no data points remain. More colors may be added to ensure that there are enough color choices to avoid duplication.
Crosstabs are a very effective way to view typically aggregated (summarized) data in rows and columns. Generally speaking you analyze one or more measures across two or more dimensions. In this section we demonstrate the creation of a 2 Dimension, 1 Measure crosstab.

1. Create a new Crosstab style report using the UCAR Training package:

2. Ensure that your report is locked.

3. From the CPM Training Data namespace, General Ledger namespace, Date query subject, drag Fiscal Year into the Rows drop zone. When dragging into a crosstab, the zone appears as a solid dark block.

4. From the Account query subject, drag Entity Code into the Columns drop zone.

5. From the same query subject, drag the Lab Medium Description query item and nest it under the Entity Code columns.
Chapter 8 – Additional Report Options

6. From the Toolbox, drag a Query Calculation into the Measures drop zone. Name it “Average Travel Expense”, select Other expression, and complete the expression as shown:

   Expression Definition:
   
   \[
   \text{[General Ledger].[General Ledger Details].[Net Amount]} \div \text{count (distinct [General Ledger].[General Ledger Details].[Document Id])}
   \]

   Note that the measure is always reflected as #1234#, not the name of the data item.

7. Click on the measures Crosstab Intersection and change the Rollup Aggregate Function as shown:

   **Positioning**
   - Size & Overflow
   
   **Data Item**
   
<table>
<thead>
<tr>
<th>Type</th>
<th>Data Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Average Travel Expense</td>
</tr>
<tr>
<td>Label</td>
<td></td>
</tr>
<tr>
<td>Expression</td>
<td>[General Ledger].[General Ledger Details].[Net Amount] \div \text{count (distinct [General Ledger].[General Ledger Details].[Document Id])}</td>
</tr>
<tr>
<td>Aggregate Function</td>
<td>Automatic</td>
</tr>
<tr>
<td>Rollup Aggregate Function</td>
<td>Total</td>
</tr>
</tbody>
</table>

8. Add an Advanced Detail Filter to limit the data to Entity Codes NCAR, UCAR, and UOP.

   Expression Definition:
   
   \[
   \text{[Entity Code]} \in ('NCAR', 'UOP', 'UCAR')
   \]

9. Add a second Advanced Detail Filter to limit the data to travel-related Object Codes:

   Expression Definition:
   
   \[
   \text{[General Ledger].[General Ledger Details].[Object Code]} \text{ starts with '54'}
   \]

10. Add a third Advanced Detail Filter to not show Fiscal Year 2011.

   Expression Definition:
   
   \[
   \text{[Fiscal Year]} \not= 2011
   \]

11. Select Fiscal Year and sort Ascending.
13. Ctrl-click all cells in the crosstab and add borders.
14. Run the report as it stands.

15. Select the Average Travel Expense measure on the Report Page, click the Aggregate icon in the Toolbar, and select Total to create overall totals for Fiscal Year, Entity Code, and Lab Medium Description.

16. Ctrl-click to select all the new Totals and the Average Travel Expense measure and change the Data Format to Currency.

17. Change the footer summary labels to read “Total for Fiscal Year”, “Total for Labs,” and “Total for Entities” so that your crosstab looks as follows:

18. Ctrl-click the new totals cells and add borders.
19. Save the report specification as **Crosstab** and run the report.

### Conditional Formatting

Conditional formatting allows the report author to dynamically control the look and feel of a report based on “conditions” that are met in the environment or the data. Examples include:

- Showing and Hiding report objects
- Changing font/color/backgrounds
- Changing displayed language
- Creating dynamic header/footer/title information

### Step-By-Step

**Customizing Reports with Conditional Formatting**

In this example, we highlight crosstab cells when the Net Amount measure reaches a certain threshold (> 1,500).

1. Use the **Crosstab** from the prior example.
2. The first step in conditional formatting is to create a variable that monitors the condition. Mouse over the Condition Explorer (just under Query Explorer) and select Variables.
3. Add a new BOOLEAN variable (by double-clicking or dragging into the Variables panel), with the expression definition of Average Travel Expense > 1500.

4. Change the Name property to “TE Threshold”. This expression is evaluated for every intersection (measure cell) of the Crosstab and is evaluated to True or False (Yes or No).

The next step is to associate a report object with this new variable. In this case we associate the Measures cell of our crosstab with the new variable.

5. Return to the report page and select the Measures area. Set the Style Variable property by clicking on the ellipsis and selecting your variable from the available drop-down.

6. The final step is to use the Condition Explorer which allows you as the report author to simulate a certain outcome for your variable. This time when you open the Condition Explorer you see the variable you just created with the Yes and No outcomes. Navigate to the Yes outcome for our variable. Note that the vertical Explorer Bar turns green whenever a specific variable outcome is selected.

7. With the Condition Explorer set to Yes and the measure still selected, change the Background Color property to Lime.
Chapter 8 – Additional Report Options

8. Run the report. Each intersection where Average Travel Expense > 1500 is now green.

<table>
<thead>
<tr>
<th>Average Travel Expense</th>
<th>UOP</th>
<th>UCAR</th>
<th>NCAR</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Total for Labs</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Research App.</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>2006</td>
<td>$1,220.55</td>
<td>$3,659.05</td>
<td>$4,075.00</td>
</tr>
<tr>
<td>2007</td>
<td>$1,165.89</td>
<td>$1,165.89</td>
<td>$1,610.23</td>
</tr>
<tr>
<td>2008</td>
<td>$1,344.77</td>
<td>$1,344.77</td>
<td>$960.37</td>
</tr>
<tr>
<td>2009</td>
<td>$1,266.65</td>
<td>$1,266.65</td>
<td>$826.02</td>
</tr>
<tr>
<td>2010</td>
<td>$1,334.53</td>
<td>$1,334.53</td>
<td>$1,032.39</td>
</tr>
<tr>
<td>Total for Fiscal Year</td>
<td>$6,352.43</td>
<td>$3,659.05</td>
<td>$10,011.48</td>
</tr>
</tbody>
</table>

9. Mouse over the Condition Explorer again; this time select the No outcome. Change the background color of the measure cell to Yellow and run the report.

<table>
<thead>
<tr>
<th>Average Travel Expense</th>
<th>UOP</th>
<th>UCAR</th>
<th>NCAR</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Total for Labs</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Research App.</td>
<td>N/A</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>2006</td>
<td>$1,220.55</td>
<td>$3,659.05</td>
<td>$4,879.80</td>
</tr>
<tr>
<td>2007</td>
<td>$1,165.89</td>
<td>$1,165.89</td>
<td>$1,010.23</td>
</tr>
<tr>
<td>2008</td>
<td>$1,344.77</td>
<td>$1,344.77</td>
<td>$960.37</td>
</tr>
<tr>
<td>2009</td>
<td>$1,266.65</td>
<td>$1,266.65</td>
<td>$826.02</td>
</tr>
<tr>
<td>2010</td>
<td>$1,334.53</td>
<td>$1,334.53</td>
<td>$1,032.39</td>
</tr>
<tr>
<td>Total for Fiscal Year</td>
<td>$6,352.43</td>
<td>$3,659.05</td>
<td>$16,011.48</td>
</tr>
</tbody>
</table>

10. Double-click the green Explorer Bar to return to the report specification independent of a condition existing.

11. Save the report specification as **Conditional Formatting**.
Chapter 8 – Additional Report Options

Repeaters

Repeaters are similar to lists in that they generally show data elements on a row by row (detail) basis. The common example used for repeaters is for creating Mailing Labels. However, repeaters also can be used for creating block style reports, or for a nice looking Header in a Header/Detail report such as a Purchase Order or Invoice.

Step-By-Step

Creating Repeaters

In this example we create a simple repeater that produces a list of individuals booked for August.

1. Let’s return to the UCAR Training package and create a new Repeater Table style report.
2. Select your Repeater Table (use the Ancestor button and move up one level from Repeater Table Cell to Repeater Table) and note you could change the Across/Down properties.

<table>
<thead>
<tr>
<th>Properties - Repeater Table</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
</tr>
<tr>
<td>Repeater Direction</td>
</tr>
<tr>
<td>Across</td>
</tr>
<tr>
<td>Down</td>
</tr>
<tr>
<td>Pagination</td>
</tr>
</tbody>
</table>

3. Click anywhere on the page, outside of the Repeater Table, then click back in the Repeater to ensure that you are highlighting the Repeater Table Cell.
4. From the Table menu, insert a 4 x 4 table into your Repeater Table Cell and click the Maximize width and Show borders check boxes.

5. Drag Text Items from the Insertable Objects Toolbox into the left hand column cells of your Repeater as shown:

6. From the Object Code query subject, add the Object Code query item to the first row, 2\textsuperscript{nd} column of your table.

7. From the General Ledger Details query subject, add the Person Entity Identifier – PEID query item to the 2\textsuperscript{nd} column, 2\textsuperscript{nd} row of the table.

8. Add the following data items from the General Ledger Details query subject into the 3\textsuperscript{rd} row of your table, starting in the 2\textsuperscript{nd} column, from left to right:
   - Post Date
   - Document Id
   - GL Transaction Description
9. Add the following data items from the same query subject into the 4th row of your table, starting in the 2nd column, from left to right:
   - Units
   - Net Amount

10. Select Net Amount and format the data as **Currency**.

11. Apply the following Advanced Detail Filters to your report to restrict the data as shown:

    Expression Definition:
    ```
    [Object Code] starts with '54'
    ```

    Expression Definition:
    ```
    [General Ledger].[Date].[Fiscal Year] = 2010
    ```

    Expression Definition:
    ```
    [General Ledger].[Date].[Month Name] = 'June'
    ```

    Expression Definition:
    ```
    [General Ledger].[General Ledger Details].[Account Key] = 150030
    ```
Chapter 8 – Additional Report Options

12. Select your repeater table by clicking on the red dots in the upper left corner:

13. Set the Size and Overflow property of your Repeater Table to 100% width.

14. Save the report specification as `Repeater`.
15. Run your report as a PDF file.
Creating a Template

Let’s end this Report Studio Part 1 training by demonstrating how to set up a template business users can use in Query or Analysis Studio.

1. Click on New , select Report Template, and click OK.

Note that there is no Metadata available in the template:

2. From the Toolbox, drag a Table (1 column, 4 rows) into the Page Header before the first block.
3. Drag the original top block (with the larger text) into the 2nd row of the table.
4. Drag the next block (with the smaller text) into the 3rd row of the table.
5. Drag the block with the Filter icon and text into the bottom row of the table.
6. Drag an Image object from the Toolbox into the top row of the table.
7. Set the URL property for this image to:

   https://fagrand.fanda.ucar.edu/cpmimages/ucar-logo-spellout-med.jpg

8. In your 2nd row, edit the larger text to read “Your Report Title Here”.
9. Edit the smaller text in the next row to read “Your Report Sub-Title Here”.
10. Select the two title blocks and set the Horizontal Alignment Left.
11. Select the Report Title block and add a border to the bottom of the cell as shown here:

![Border dialog box](image)

12. Add a similar border to the bottom of the Report Sub-Title block with the width 1 ½ pt.

13. Save your template as Template.
14. To open a new report using this template, open a new report, selecting the **UCAR Training** package, and the Existing option.

15. Navigate to your Template report (Chapter 8).